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Chapter 220

Mixed Models - General

Introduction

The Mixed Models procedure analyzes results from a wide variety of experimental designs in which the
outcome (response) is continuous, including

e Two-sample designs (replacing the t-test)

e One-way layout designs (replacing one-way ANOVA)

e Factorial designs (replacing factorial GLM)

e Split-plot designs (replacing split-plot GLM)

e Repeated-measures designs (replacing repeated-measures GLM)

e Cross-over designs (replacing GLM)

e Designs with covariates (replacing GLM)
The Mixed Models procedure can be used to test and estimate means (including pair-wise comparisons
among levels), compare models, estimate variance-covariance matrix components, and produce graphs of
means and repeated measurements of subjects. Examples are given in this chapter of models with only

between-subjects factors, only within-subjects factors, and both between- and within-subjects factors.
Analysis of covariance examples and multiple comparisons examples are also included.

Why Use a Mixed Model?

As stated above, mixed models have several advantages over traditional linear models. Just a few are listed
here.

o Specifying More Appropriate Variance-Covariance Structures for Longitudinal Data: The ability
to fit complex covariance patterns provides more appropriate fixed effect estimates and standard
errors.

e Analysis Assuming Unequal Group Variances: Different variances can be fit for each treatment
group.

¢ Analysis of Longitudinal Data with Unequal Time Points: Mixed models allow for the analysis of
data in which the measurements were made at random (varying) time points.

e Analysis of Longitudinal Data with Missing Response Data: Problems caused by missing data in
repeated measures and cross-over trials are eliminated.

e Greater Flexibility in Modeling Covariates: Covariates can be modeled as fixed or random and
more accurately represent their true contribution in the model.
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Mixed models are particularly useful in medical studies where a wide variety of factors influence the
response to a treatment of interest. For example, suppose that an experimental treatment is being
administered to a group of patients desiring to lose weight. Traditional statistical methodologies (e.g.,
ANOVA, multiple regression, etc.) require that the treatments be given at the same time intervals for all
patients in the group in order for the statistical analysis and conclusions to be accurate. What would happen
if patients were not all able to receive the treatment at the same time intervals or if some patients missed
some treatments? Traditional statistical approaches would no longer be valid since there are random events
or components entering into the experiment. This is where mixed models techniques become useful. A
mixed model would allow us to make inferences about the treatment by modeling and estimating the
random components. Furthermore, mixed models allow us to make greater use of incomplete data, such as
that obtained from patients who drop out or miss scheduled treatments. Traditional methods would
exclude such individuals from the analysis, losing valuable information.

What is a Mixed Model?

In a general linear model (GLM), a random sample of the individuals in each population is drawn. A
treatment is applied to each individual in the sample and an outcome is measured. The data so obtained
are analyzed using an analysis of variance table that produces an F-test.

A mathematical model may be formulated that underlies each analysis of variance. This model expresses
the response variable as the sum of parameters of the population. For example, a linear model for a two-
factor experiment could be

Yijk =u + a; + bj + (ab)u + eijk

wherei=1, 2, ..., I (the number of levels of factor 1), j=1, 2, ...,/ (the number of levels of factor 2), and k =
1,2, ..., K (the number of subjects in the study). This model expresses the value of the response variable, Y,
as the sum of five components:

u the mean.
a; the contribution of the it" level of a factor A.
b; the contribution of the j! level of a factor B.

(ab);; the combined contribution (or interaction) of the /™ level of a factor A and the /™ level of a factor
B.

€ijk the contribution of the k™ individual. This is often called the “error.”
In this example, the linear model is made up of fixed effects only. An effect is fixed if the levels in the study

represent all levels of the factor that are of interest, or at least all levels that are important for inference
(e.g., treatment, dose, etc.).

The following assumptions are made when using the F-test in a general linear model.
1. The response variable is continuous.
2. Theindividuals are independent.
3. The ej follow the normal probability distribution with mean equal to zero.
4

The variances of the ejx are equal for all values of /, j, and k.
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The Linear Mixed Model (or just Mixed Model) is a natural extension of the general linear model. Mixed
models extend linear models by allowing for the addition of random effects, where the levels of the factor
represent a random subset of a larger group of all possible levels (e.g., time of administration, clinic, etc.).
For example, the two-factor linear model above could be augmented to include a random block effect such
as clinic or doctor since the clinic or doctor may be assumed to be a random realization from a distribution
of clinics or doctors. Covariates (continuous) and/or nested effects can also be included in the mixed model
to improve the accuracy of the fixed effect estimates. The general form of the mixed model in matrix
notation is

y=XB+Zu+¢

where
y vector of responses
X known design matrix of the fixed effects
B unknown vector of fixed effects parameters to be estimated
Z known design matrix of the random effects
u unknown vector of random effects

€ unobserved vector of random errors

We assume
u~N(0,G)
e~N(O,R)
Covlu,g] =0
where

G variance-covariance matrix of u

R variance-covariance matrix of the errors €

The variance of y, denoted V, is
V = Varl|y]
= Var[XB + Zu + €]
= 0 + Var[Zu + €]
=1ZGZ' +R
In order to test the parameters in B, which is typically the goal in mixed model analysis, the unknown
parameters (B, G, and R) must be estimated. Estimates for 8 require estimates of G and R. In order to

estimate G and R, the structure of G and R must be specified. Details of the specific structures for G and R
are discussed later.

The following assumptions are made when using the F-test in a mixed model.
1. The response variable is continuous.
2. Theindividuals are independent.
3. The random error follows the normal probability distribution with mean equal to zero.
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A distinct (and arguably the most important) advantage of the mixed model over the general linear model is
flexibility in random error and random effect variance component modeling (note that the equal-variance
assumption of the general linear model is not necessary for the linear mixed model). Mixed models allow
you to model both heterogeneous variances and correlation among observations through the specification
of the covariance matrix structures for u and €. You should be careful to build an appropriate covariance
structure for the model, since the hypothesis tests, confidence intervals, and treatment mean estimates are
all affected by the covariance structure of the model. The variance matrix estimates are obtained using
maximum likelihood (ML) or, more commonly, restricted maximum likelihood (REML). The fixed effects in
the mixed model are tested using F-tests. More details of random factor estimation and fixed factor
estimation and testing are given later in this chapter.

Types of Mixed Models

Several general mixed model subtypes exist that are characterized by the random effects, fixed effects,
covariate terms, and covariance structure they involve. These include fixed effects models, random effects
models, covariance pattern models, and random coefficients models.

Fixed Effects Models

A fixed effects model is a model where only fixed effects are included in the model. An effect (or factor) is
fixed if the levels in the study represent all levels of interest of the factor, or at least all levels that are
important for inference (e.g., treatment, dose, etc.). No random components are present. The general linear
model is a fixed effects model. Fixed effects models can include covariates and/or interactions. The two-
factor experiment example above gives an example of a fixed effects model. The fixed effects can be
estimated and tested using the F-test. Fixed effects are specified as the Fixed Factors Model on the Variables
tab.

Note: If only one response is recorded for each subject, there is no within-subject correlation to be modeled
in variance-covariance matrix. If more than one response is measured for each subject, you could use
repeated measures ANOVA or use a random-coefficients mixed model.

Random Effects Models

A random effects model is a model with only random terms in the model. An effect (or factor) is random if the
levels of the factor represent a random subset of a larger group of all possible levels (e.g., patients
represent the population as a whole). Random effects are specified in the Subject (Random) Model box on
the Variables tab. The random effects are not tested, but estimates are given.

Note: If only one response is recorded for each subject, there is no within-subject correlation to be modeled
in variance-covariance matrix. If more than one response is measured for each subject, you could use
repeated measures ANOVA or use a random coefficients mixed model.
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Longitudinal Data Models

Longitudinal data arises when more than one response is measured on each subject in the study.
Responses are often measured over time at fixed or random intervals. An interval is fixed if the
measurements are made a pre-specified time intervals, e.g., measuring heart rate after 2 hours, 4 hours,
and 6 hours after drug administration. An interval is random if the response measurements are made at
random time points, e.g., measuring heart rate at the start of a race and after each runner finishes
(presumably at differing time points). Various covariance structures can be employed to model the variance
and correlation among repeated measurements or the relationship with time can be investigated. The
manner in which the longitudinal data is modeled gives rise to two different mixed model subtypes:
covariance pattern models and random coefficients models.

Covariance Pattern Models

If the covariance and correlation between repeated measurements is taken into account (i.e. modeled), the
model is called a covariance pattern model. The covariance pattern model is usually appropriate if the
repeated measurements occur at fixed intervals and the relationship with time in not of particular interest.
More information is given later in the chapter about the different covariance patterns that can be fit.

The repeated or residual covariance pattern is specified in the Repeated Variance Pattern box on the
Variables tab.

Random Coefficients Models

It is often important in a study to determine the relationship between the response and time. This is often
done by including the measurement time as a covariate in the model, with a corresponding slope, say B It is
plausible and likely that the slope will vary with subject, so it might be useful to model a separate intercept
and slope for each subject in the study. This is done by fitting the subject variable as the intercept and the
subject*time interaction as the slope for each patient. These two terms could reasonably be assumed to
arise at random from a distribution and, thus, would be specified as random effects. This gives rise to what
is called a random coefficients model.

A random coefficients model is one in which the subject term and a subject*time interaction term are both
included as random effects in the model. This type of model is different from an ordinary random effects
model because when we fit a straight line, the estimates of the slope and intercept are not independent.
Thus, the subject and subject*time effects in the model are correlated. The random effects model must be
adapted to this situation to allow for correlation among these random effects. This is done using the
bivariate normal distribution. The bivariate random effect becomes

subject;,
( , . ~N(0,G),
(subject * time),
where
2
G = ( asubject asubject,subject*time>
- 2
Osubject,subjectstime Usubject*time

The random coefficients model is usually used if the relationship with time is of interest or if the repeated
measurements do not occur at fixed intervals. Random coefficient effects are specified in the Random
Factor box on the Variables tab. Other fixed and random effects, besides time, can also be specified in the
random coefficients model.

220-5
© NCSS, LLC. All Rights Reserved.


http://www.ncss.com/

NCSS Statistical Software NCSS.com

Mixed Models - General

Examples

Because of the large number of options, attempting to enter the appropriate model in the Mixed Models
procedure can be intimidating. A number of examples at the end of the chapter are provided with the hope
that one of the examples is similar enough to your scenario that it will guide you in selecting the options
that are appropriate. The examples can also serve as a tutorial, beginning with the simplest two-group
modeling in Example 2 (Example 1 is used for annotation) and continuing into more complex models.

Several of the examples also provide comparisons to analyses using classical procedures. For example,
Example 3 compares the classical one-way analysis using the One-Way ANOVA procedure to the equivalent
analysis using the Mixed Models procedure.

The examples at the end of this chapter are categorized in two ways.
1. The number of between-subject and within-subject factors

2. The experimental design or analysis method used

A brief explanation of between-subject factors and within-subject factors precedes the table of examples.

Between-Subject Factors

Between-subject factors are those factors for which several subjects are assigned to (or sampled from) each
level. If 12 subjects are randomly assigned to 3 treatment groups (4 subjects per group), treatmentis a
between-subject factor.

Within-Subject Factors
Within-subject factors are those in which the subject's response is measured at several time points.

Within-subject factors are those factors for which multiple levels of the factor are measured on the same
subject. If each subject is measured at the low, medium, and high level of the treatment, treatment is a
within-subject factor.

Example Overview

Example 1 has one within-subject factor and one between-subject factor, as well as a covariate. For Example
1, the output is annotated in detail. The remaining examples show the set-up and basic analysis.

Example Design/Analysis Numbt.ar of Between- Numl.aer of Within- Numb.er of

Subject Factors Subject Factors Covariates
1 Repeated Measures (+ Annotation) 1 1 1
2a Two-Group T-Test (Equal Variance) 1 0 0
2b Two-Group T-Test (Unequal Variance) 1 0 0
2c Two-Group T-Test (+ Covariate) 1 0 1
3a One-Way (Equal Variance) 1 0 0
3b One-Way (Unequal Variance) 1 0 0
4 One-Way (+ Covariate) 1 0 1
5 Factorial (+ Covariate) 2 0 1
6 RCBD 0 1 0
7 Complex Split-Plot 1 2 2
8 Cross-Over 0 2 1
9 Repeated Measures (Unequal Time Points) 1 0 1
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Random versus Repeated Error Formulation

The general form of the linear mixed model as described earlier is
y=XB+Zu+e¢
u~N(0,G)
€~N(O,R)
Cov[u,g] =0
V=1ZGZ' +R

The specification of the random component of the model specifies the structure of Z, u, and G. The
specification of the repeated (error or residual) component of the model specifies the structure of € and R.
Except in very complicated designs, it is recommended that only one of the two components be specified.
That is, if the random component includes one or more terms, the repeated pattern should be the diagonal
(basic) pattern. If the repeated pattern is more complicated than a diagonal, there should not be a random
component. There are exceptions, but the resulting covariance structure should be carefully considered in
such cases.

Specifying the random component of the model will suffice for most factorial, split-plot, and ANCOVA
designs and for longitudinal designs with irregular time values. The repeated component of the model
should be used for longitudinal analyses with a fixed number of time points (e.g., 1 hour, 2 hours, 4 hours, 8
hours), and where there are no, or very few, missing values.

In some scenarios, specifying a repeated pattern results in the same covariance parameter formulation as a
random component. For example, specifying compound symmetry for the repeated pattern with no random
component will result in the sample within-subject variance matrix as specifying Subject as the random
factor and Diagonal for the repeated pattern. The examples of this chapter can be used to see the random
and repeated specification for several common analyses.

Determining the Correct Model of the Variance-Covariance of Y

Akaike Information Criterion (AIC) for Model Assessment

Akaike information criterion (AIC) is tool for assessing model fit (Akaike, 1973, 1974). The formula is
AIC =-2XL+2p

where L is the (ML or REML) log-likelihood and p depends on the type of likelihood selected. If the ML
method is used, p is the total number of parameters. If the REML method is used, p is the number of
variance component parameters.

The formula is designed so that a smaller AIC value indicates a “better” model. AIC penalizes models with
larger numbers of parameters. That is, if a model with a much larger number of parameters produces only a
slight improvement in likelihood, the values of AIC for the two models will suggest that the more
parsimonious (limited) model is still the “better” model.
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As an example, suppose a researcher would like to determine the appropriate variance-covariance structure
for a longitudinal model with four equal time points. The researcher uses REML as the likelihood type. The
analysis is run five times, each with a different covariance pattern, and the AIC values are recorded as
follows.

Pattern Number of Parameters | -2 log-likelihood | AIC
Diagonal 1 214.43 216.43
Compound Symmetry 2 210.77 214.77
AR(1) 2 203.52 207.52
Toeplitz 4 198.03 206.03
Unstructured 7 197.94 211.94

The recommended variance-covariance structure among these five is the Toeplitz pattern, since it results in
the smallest AIC value.

What to Do When You Encounter a Variance Estimate that is Equal to Zero

It is possible that a mixed models data analysis results in a variance component estimate that is negative or
equal to zero. This is particularly true in the case of random coefficients models. When this happens, the
component that has a variance estimate equal to zero should be removed from the random factors model
statement (or, if possible, the repeated pattern should be simplified to ‘diagonal’), and the analysis should
be rerun.

As an example, suppose a researcher would like to analyze a dataset using a random coefficients model.
The data consists of sixty subjects, each of which received one of three treatments. The weight of each
subject was measured at the beginning of the study and 6, 12 18, 24, and 30 days after administration of the
treatment. The fixed and random factors models are entered as follows:

Fixed Factors Model: Day Trt Day*Trt
Random Factors Model: Subject Subject*Day
Repeated (Time) Variance Pattern: Diagonal

The mixed models analysis results in the following variance component parameter estimates:

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model

Number Number Value Term

1 1 0.000000 Subject

1 2 0.031682 Subject*Day
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Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 12.914745 Diagonal (Variance)

RUN ABORTED BECAUSE OF ZERO PARAMETER #**xxiiskiiiiiik
Error Explanation:

One or more of the above parameter estimates is zero.

The corresponding term should not be included in the model.

The term must be removed from the model and then the problem rerun in order to obtain
the rest of the reports and charts.

Fkkdhkkkkkkkkk Fokkdkkkkhkkkkk

The estimated value for the Subject random component is equal to zero and should be removed from the
analysis. Re-running the analysis without the Subject component in the random factors model results in the
following parameter estimates:

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 0.030111 Subject*Day

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 12.517215 Diagonal (Variance)

The variance estimates for the other parameters changed slightly after removing Subject from the random
factors model.

Fixed Effects

A fixed effect (or factor) is a variable for which levels in the study represent all levels of interest, or at least
all levels that are important for inference (e.g., treatment, dose, etc.). The fixed effects in the model include
those factor for which means, standard errors, and confidence intervals will be estimated and tests of
hypotheses will be performed. Other variables for which the model is to be adjusted (that are not important
for estimation or hypothesis testing) may also be included in the model as fixed factors. Fixed factors may
be discrete variables or continuous covariates.

The correct model for fixed effects depends on the number of fixed factors, the questions to be answered
by the analysis, and the amount of data available for the analysis. When more than one fixed factor may
influence the response, it is common to include those factors in the model, along with their interactions
(two-way, three-way, etc.). Difficulties arise when there are not sufficient data to model the higher-order
interactions. In this case, some interactions must be omitted from the model. It is usually suggested that if
you include an interaction in the model, you should also include the main effects (i.e., individual factors)
involved in the interaction even if the hypothesis test for the main effects in not significant.
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Covariates

Covariates are continuous measurements that are not of primary interest in the study, but potentially have
an influence on the response. Two types of covariates typically arise in mixed models designs: subject
covariates and within-subject covariates. They are illustrated in the following example.

A study is conducted to determine the effect of two drugs on heart rate in mice. Each mouse receives each
drug and a placebo with a washout period between treatments. The weight of each mouse is measured
prior to the first treatment. The systolic blood pressure of each mouse is also measured immediately before
each treatment. Although potentially an important factor, order of treatment is not considered in this
example.

Mouse | IWeight | Treatment | BP | HR
1 18 Placebo 154 | 392
1 18 Drug A 167 | 378
1 18 Drug B 184 | 365
2 26 Placebo 166 | 402
2 26 Drug A 189 | 396
2 26 Drug B 177 | 397
3 22 Placebo 185 | 408
3 22 Drug A 163 | 402
3 22 Drug B 183 | 407
4 19 Placebo 167 | 411
4 19 Drug A 179 | 400
4 19 Drug B 172 | 392
5 15 Placebo 175 | 384
5 15 Drug A 168 | 391
5 15 Drug B 176 | 386

In this example, initial weight (IWeight) and blood pressure (BP) are covariates. IWeight is a subject covariate
because it is measured only once for each subject. BP is a within-subject covariate since it is measured on
each subject for each treatment.

The Mixed Models procedure permits the user to make comparisons of fixed-effect means at specified
values of covariates. For example, researchers could compare the two treatments to the placebo for IWeight
=20 and BP = 180, even when those values of the covariates do not appear in the actual data set.

Commonly, investigators wish to make comparisons of levels of a factor at several values of covariates. In
this example, the researchers might want to compare the two treatments to the placebo at IWeight = 18, 23,
and 26, and at BP = 160, 175, and 190. Caution should be exercised when making comparisons at multiple
covariate values. The result in this case is 3 x 3 = 9 sets of comparisons and, therefore, 3 x 9 = 27 tests (3
pair wise treatment comparisons x 9 sets = 27 tests) for the Bonferroni adjustment of the p-value. After
accounting for multiple testing, finding significant differences will require large sample sizes and/or extreme
differences in means since the raw p-value would have to be less than 0.00185 in order to declare
significance at the 0.05 level (0.05/27 = 0.00185).
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Time as a Fixed Effects Factor vs. Time as a Covariate

Time is an essential measurement in many mixed model designs. In some analyses, time may be considered
a fixed factor, while in others it is covariate. A couple of examples illustrate this distinction.

Time as a Fixed Effects Factor

Researchers wish to compare the extent to which rashes develop following administration of different doses
of an anti-fungal cream. Fifteen individuals are divided into three groups, with each group receiving a
different dose of the cream: low, medium, or high. The surface area of the resulting rash is measured at
four time points: 1 hour, 2 hours, 4 hours, and 8 hours.

Dose | Subject | Time | Rash
Low 1 1 4.2
Low 1 2 3.5
Low 1 4 2.1
Low 1 8 6.8
Low 2 1 3.4
Low 2 2 5.2
Low 2 4 9.7
Low 2 8 6.5
Low 3 1 4.1
Low 3 2 6.8
Low 3 4 7.1
Low 3 8 2.3
High 15 1 6.4
High 15 2 8.2
High 15 4 9.4
High 15 8 8.5

In this example, the time points are very structured (every subject is measured at the same time points) and
the relationship between the size of the rash and time is not likely to be linear (the relationship will likely
increase and then decrease). These two aspects of the study would generally lead the researcher to include
Time as a fixed effects factor rather than as a covariate. If, however, the relationship were linear (or could be
made linear by a suitable transformation), time could be considered a covariate. The next example
examines the case where Time must be considered a covariate.
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Time as a Covariate

Three diets are compared for recently hatched chicks for their effect on growth. One hundred forty-seven
chicks are randomly divided into three diets: low soybean protein, high soybean protein, and high fishmeal
protein. Weights of chicks are measured at unequal times for two months after beginning the diet.

Diet Chick | Time | Weight

Low Soy 1 5 64
Low Soy 1 11 69
Low Soy 1 24 74
Low Soy 1 45 101
Low Soy 2 16 72
Low Soy 2 51 143
Low Soy 3 3 57
Low Soy 3 29 81

Low Soy 3 33 83

Low Soy 3 46 126
Low Soy 3 55 155
Low Soy 4 8 72

High Fish | 146 | 52 145
High Fish | 147 | 16 78
High Fish | 147 | 33 97
High Fish | 146 | 52 145

In this example, if Time were considered a fixed-effects factor, each time point would be a different level of
the factor, yielding too many levels. The appropriate approach in this example is to include Time as a
covariate and examine the linear relationship (perhaps following a transformation) between Time and
Weight. In this example, the nature of the design requires that Time be a covariate.

Common experiments in which time should be included as a covariate are experiments involving human
subjects that don't report on schedule.

Using a Time Variable When Time is Not Measured in the
Study

Many designs (e.g., factorial, split-plot, ANCOVA) for which the use of mixed models is recommended do not
have time as a measured variable. In such cases, it can still be useful to include a time variable as an
ordering variable. This is particularly important when the dataset itself is not ordered, when there are
missing values, and when the specified covariance structure is complex. An example of a design where time
is included only for ordering purposes is a cross-over design.
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A Model-Building Strategy

There are three main components of a mixed model:

The Fixed Effects Component. The fixed effects component of the model consists of the fixed
factors, the covariates, and the interactions of fixed factors and covariates. The strength of evidence
for the true effect of each fixed effects term is given by the probability level of the corresponding F-
test.

The Random (Subject) Component. The random factors include all random factors and (possibly)
interactions of random factors with fixed factor variables or covariates. The importance of each
random term is more subjective. Inclusion or exclusion of a random term is often decided by
comparing the magnitude of the estimates. Relatively small estimates may, in some cases, be
removed from the model. The meaning of ‘relatively small’ is beyond the scope of this manual.

The Covariance Pattern of Repeated Measurements. The covariance pattern indicates the
pattern of the residual error of repeated measurements. Specific patterns are shown in detail later
in this chapter. The pattern should usually be Diagonal if a random model is specified. Patterns can
be compared by examining the AIC value for each pattern. A separate run is required for each
pattern.

The underlying goal in building a mixed model should be finding the simplest model that best fits the
observed data. A reasonable top-down strategy for building a model might include the following steps:

1.

8.

Specify all the fixed effects, covariates, and potentially important interactions in the Fixed Effects
Model.

Specify either the Random Model or the Repeated Covariance Pattern as the circumstances dictate.
Run the model.

Compare the random terms to see if any are clearly negligible (e.g., less than 20 times smaller than
the others).

Re-run the model excluding the negligible random terms.

Examine the fixed effects terms F-tests tests. Iteratively remove interaction terms from the fixed
effects model that have large probability levels until all are below, say, 0.20.

If a Repeated Covariance Pattern is of interest, re-run the analysis several times with different
patterns, comparing the AIC values. Keep the pattern with the lowest AIC value.

Run the final model with comparisons of interest and specific covariate values.

This strategy is one among many that could be used in refining a mixed model. In some cases, regulations
may dictate the terms that may or may not be included in the model, which leaves little or no room for
refinement. The order of steps given here is subjective, but perhaps gives a feel for the considerations that
should be made in determining a good model. The discussion near the end of Example 1 involving model
refinement for a specific example may also be helpful.
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Multiple Comparisons of Fixed Effect Levels

If there is evidence that a fixed factor of a mixed model has difference responses among its levels, it is
usually of interest to perform post-hoc pair-wise comparisons of the least-squares means to further clarify
those differences. It is well-known that p-value adjustments need to be made when multiple tests are
performed (see Hochberg and Tamhane, 1987, or Hsu, 1996, for general discussion and details of the need
for multiplicity adjustment). Such adjustments are usually made to preserve the family-wise error rate
(FWER), also called the experiment-wise error rate, of the group of tests. FWER is the probability of
incorrectly rejecting at least one of the pair-wise tests.

Family-Wise Error Rate (FWER) Control - Bonferroni Adjustment

The Bonferroni p-value adjustment produces adjusted p-values (probability levels) for which the FWER is
controlled strictly (Westfall et al, 1999). The Bonferroni adjustment is applied to all m unadjusted (raw) p-
values (pj) as

pj = min(mpj, 1).

That is, each p-value is multiplied by the number of tests in the set (family), and if the result is greater than
one, it is set to the maximum possible p-value of one.

The Bonferroni adjustment is generally considered to be a conservative method for simultaneously
comparing levels of fixed effects.

In the following example, four levels of a fixed factor are compared (all pairs): A, B, C, and D.

Multiple Comparison Example - Main Effects

Test | Raw P-value | Bonferroni-Adjusted P-value
Avs B | 0.01435 0.08610
Avs C | 0.00762 0.04572
AvsD | 0.00487 0.02922
Bvs C | 0.34981 1.00000
Bvs D | 0.06062 0.36372
Cvs D | 0.71405 1.00000

In this example, the adjustments are based on m = 6 tests.
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Multiple Comparisons for the Interaction of Two Main Effects

When examining a fixed effect interaction using post-hoc (or planned) multiple comparison tests, a useful
method is to compare all levels of one factor at each level of the other factor. This method is termed ‘slicing'.
For example, if the interaction of Time and Treatment is significant, comparing the treatment levels at each
time point could aid in understanding the nature of the interaction.

Multiple Comparison Example - Interaction

Time Test | Raw P-value | Bonferroni-Adjusted P-value
1 hour Avs B | 0.25186 1.00000
1 hour Avs C [ 0.00118 0.02124
1 hour AvsD | 0.13526 1.00000
1 hour Bvs C | 0.07275 1.00000
1 hour Bvs D | 0.12994 1.00000
1 hour Cvs D | 0.08068 1.00000
5hours | AvsB | 0.11279 1.00000
5hours | AvsC | 0.01779 0.32022
5hours | AvsD | 0.18634 1.00000
5hours | BvsC | 0.07291 1.00000
5hours | BvsD | 0.05254 0.94572
5hours | CvsD | 0.03883 0.69894
10 hours | Avs B | 0.14701 1.00000
10 hours | Avs C | 0.02798 0.50364
10 hours | Avs D | 0.15722 1.00000
10 hours | Bvs C | 0.13614 1.00000
10 hours | Bvs D | 0.10642 1.00000
10 hours | Cvs D | 0.16751 1.00000

In this example, the adjustments are based on m = 18 tests. It can be seen from this example that
minimizing the number of tests enhances the power to detect significant differences.

Multiple Comparisons for Several Covariate Levels

When more than one covariate value is specified for ‘Compute Means at these Values' on the Covariates tab,
the number of test used in the Bonferroni adjustment can increase dramatically. The number of tests for
the Bonferroni adjustment is computed as

Number of Tests = Number of Comparisons per Set x Number of Covariate Sets

As an example, suppose that an experiment has two covariates, and a single fixed treatment factor with
three levels: Control, T1, and T2. If ‘All Pairs’ were selected as the comparison on the Comparisons tab, then
the number of comparisons per set would be three (T1 - Control, T2 - Control, and T2 - T1). Suppose that
the researcher desired to compute the hypothesis tests at two values for the first covariate and four values
for the second. The number of covariate sets would be 2 x 4 = 8. Therefore, the number of tests used in the
Bonferroni adjustment to conserve the overall error-rate would be 3 x 8 = 24. The raw p-value would have to
be less than 0.05/24 = 0.00208 in order to declare significance at the 0.05 level.
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This example illustrates that care must be taken when specifying the covariate values at which the means
and analyses will be computed. As more covariate values are specified, the number of tests in the
adjustment increases making it more and more difficult to find differences that are significant.

Mixed Model Technical Details

As stated previously, the general form of the linear mixed model is

y=XB+Zu+e¢

where
y vector of responses
X known design matrix of the fixed effects
B unknown vector of fixed effects parameters to be estimated
Z known design matrix of the random effects
u unknown vector of random effects
€ unobserved vector of random errors
We assume
u~N(0,G)
e~N(0,R)
Covlu,g] =0
where

G variance-covariance matrix of u

R variance-covariance matrix of the errors €

The variance of y, denoted V, is
V = Var|y]
= Var[XB + Zu + €]
= 0 + Var[Zu + €]
=ZGZ' +R
In order to test the parameters in B, which is typically the goal in mixed model analysis, the unknown

parameters (B, G, and R) must be estimated. Estimates for 8 require estimates of G and R. In order to
estimate G and R, the structure of G and R must be specified. Structures for G and R are discussed later.
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Individual Subject Formulation

Because of the size of the matrices that are involved in mixed model analysis, it is useful for computational
purposes to reduce the dimensionality of the problem by analyzing the data one subject at a time. Because
the data from different subjects are statistically independent, the log-likelihood of the data can be summed
over the subjects, according to the formulas below. Before we look at the likelihood functions, we examine
the linear mixed model for a particular subject:

yi=XiB+Ziui+£i, i=1,...,N
where

y; nix1 vector of responses for subject /.

X; nixp design matrix of fixed effects for subject i (p is the number of columns in X).

B px1 vector of regression parameters.

Z; nixq design matrix of the random effects for subject i.

u; @gx1 vector of random effects for subject / which has means of zero and covariance matrix Gsus.
g; nix1 vector of errors for subject j with zero mean and covariance R,

n; number of repeated measurements on subject /.

N number of subjects.
The following definitions will also be useful.

e; vector of residuals for subjecti(e; =y; — X;B)

V; Varly;] = Z;GsypZ; + R;

To see how the individual subject mixed model formulation relates to the general form, we have

;71 §1 Z, 0 0 31 s1
y= 22 ,X= ;2 ,Z=<0 - 0>Iu= :2 I£= 22
YN XN 0 0 Zy uy €

Likelihood Formulas

Rather than maximizing the likelihood function, it is convenient (for theoretical and practical reasons
beyond the scope of this manual) to minimize -2 times the log likelihood function rather than maximize the
likelihood function itself. There are two types of likelihood estimation methods that are generally
considered in mixed model estimation: maximum likelihood (ML) and restricted maximum likelihood
(REML). REML is generally favored over ML because the variance estimates using REML are unbiased for
small sample sizes, whereas ML estimates are unbiased only asymptotically (see Littell et al., 2006 or
Demidenko, 2004). Both estimation methods are available in NCSS.
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Maximum Likelihood
The general form -2log-likelihood ML function is

—2Ly.(B,G,R) =In|V| + €'V~ e + Ny In(27)

The equivalent individual subject form is

N
—2Lu;(B,G,R) = Z(laniI +ejV;'e;) + Ny In(2m)

=1

where Ny is the total number of observations, or

N
NT = ZTLL-
=

1

Restricted Maximum Likelihood

The general form -2log-likelihood REML function is
_ZLREML(ﬂ' G, R) = 1n|V| + e’V_le + 1n|X’V_1X| + (NT - p) 1n(27‘[)

The equivalent individual subject form is

N
2L pgr (B G, R) = Z[lanil +elVile] +1n

i=1

N

2 X\vilx;

=1

+ (Ny — p) In(2m)

where, again, Ny is the total number of observations, or

N
NT = Z nl‘
=1

1

and p is the number of columns in X or X;.

The G Matrix

NCSS.com

The G matrix is the variance-covariance matrix for the random effects u. Typically, when the G matrix is
used to specify the variance-covariance structure of y, the structure for R is simply a?1. Caution should be
used when both G and R are specified as complex structures, since large numbers of sometimes redundant

covariance elements can result.

The G matrix is made up of N symmetric Gg,;, matrices,

Gy 0 O - O

0 Gg, O - O

G=| 0 0 Gy 0

0 0 0 - Gy
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The dimension of Ggyp, is g X g, where g is the number of random effects for each subject.

Structures of Gsup

There are two commonly used structures for the elements of the Gy,;, matrix: diagonal and unstructured.

Diagonal Gsu» Unstructured Gsu»
2 2
o1 01 012 013 O14
2 2
G _ 03 G _| %21 02 023 O34
sub — 2 sub — 2
03 031 032 03 O34
2 2
Oy 041 Oz2 043 Oy

The diagonal Gg,;, should be used when there is no covariance between parameters, such as in the random
effects models. The unstructured Gy}, is typically used when you want to include covariances, such as in
random coefficients models.

The R Matrix

The R matrix is the variance-covariance matrix for errors, €. When the R matrix is used to specify the
variance-covariance structure of y, the Gg,;, matrix is not used.

The full R matrix is made up of N symmetric R sub-matrices,

R, 0 0 - 0
0O R, 0 ~ 0

R= 0 0 R3 °ee 0 )
0 0 0 - Ry

where Rq,R,, R3, -+, Ry are all of the same structure, but, unlike the Gg,;, matrices, differ according to the
number of repeated measurements on each subject.

When the R matrix is specified in NCSS, it is assumed that there is a fixed, known set of repeated
measurement times. (If the repeated measurement times are random, specification of the Gg,,;, matrix with
R = 621 should be used instead for specifying covariance structure.) Thus, the differences in the dimensions
of the R sub-matrices occur only when some measurements for a subject are missing.

As an example, suppose an R sub-matrix is of the form

Roup = a3 ’
o2 /
ad

where there are five time points at which each subject is intended to be measured: 1 hour, 2 hours, 5 hours,
10 hours, and 24 hours. If the first subject has measurements at all five time points, then n, =5, and the
sub-matrix is identical to Ry, above, and Ry = Ry
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Suppose the second subject is measured at 1 hour, 5 hours, and 24 hours, but misses the 2-hour and 10-
hour measurements. The R, matrix for this subject is

For this subject, n, = 3. That is, for the case when the time points are fixed, instead of having missing values
in the R sub-matrices, the matrix is collapsed to accommodate the number of realized measurements.
Structures of R

There are many possible structures for the sub-matrices that make up the R matrix. The Ry, structures that
can be specified in NCSS are shown below.

Diagonal
Homogeneous Heterogeneous Correlation

0.2 0'12 1

a? a3 1
a2 o? 1
o2 o2 1

Compound Symmetry
Homogeneous Heterogeneous Correlation

o* pa® po* pa? of  poyo; PO Poyoy 1 p p p

pa* o* pa® po? po201 0 P00z P00y p 1 pp

pc? po? % po? pO30; pPO30, OF  pO30 p p 1 p

po® pa* pa® a? P40y PO4O, PO Of ppop 1
AR(T)
Homogeneous Heterogeneous Correlation

a*  po* p?o* pic? of  poo, pPoyos pioioy 1 p p* p’
po? o? po? po? po201 o3 poy03  pt0,04 p 1 p p?
p*c® po® a*  pa® p’os0y pozo, 05 pozay | | PP p 1 p
pia® p?c® po®  o? pio,01 pPo,o, posos  Of p> p* p 1
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AR(Time Diff)
Homogeneous Heterogeneous
o2 ptatig?  pts=tig?  pta=tis? 0,2 ptrtigig, ptstigia, pttiogo,
ptatig? o2 pts~tag?  pta=tz g2 pttig, g, 0,2 ptstg,0,  ptiteg,a,
pts~tig?  pts—ts2 o2 pta~ts g2 ptitigag, ptsitegya, 052 ptitsg,a,
ptatig?  pta—tag?  pta=ts ;2 o2 ptitig,a, ptiteg,a, ptitio,o, 042
Correlation
ty—t ta—t ty—t
1 pZ 1 p3 1 p4 1
ptz—t1 1 pt3—t2 pt4—t2
pts~tr pts~tz 1 pteTts
pt4—t1 pt4—t2 pt4—t3 1
Toeplitz
Homogeneous Heterogeneous Correlation
2 2 2 2 2
o P10~ P20~ p30 41 p10102  P20103 P30104 1 p1 p2 p3
2 2 2 2 2
p10 o P10~ P20 pP10201 03 P10203  P20204 pr 1 p1 p2
2 2 2 2 2
P20~ p10 o p10 p20301 P10303 03 p10304 p2 P11 P
p30* ppo* pio* o P30401  P2040; P10403  Of Pz P2 P11
Toeplitz(2)
Homogeneous Heterogeneous Correlation
2 2 2
o p10 01 P10107 /1 P1 \
2 2 2 2
p10 o p10 pP10201 03 p10203 pr 1 p1
2 2 2 2
p10 o p10 p10307 03 P10304 \ pr 1 .01/
p10?  o? p104,03  OF pr 1
Note: This is the same as Banded(2).
Toeplitz(3)
Homogeneous Heterogeneous Correlation
2 2 2 2
o P10~ P20 01 p1010  P20103 1 p1 py
2 2 2 2 2
p10 o P10~ P20 p10207 ) P10203 20204 pr 1 p1 p2
2 2 2 2
P20~ P10 o P10 p20301 P10307 03 P10304 P2 P11 P
p20? pio?  o? P2040; P10403 i p2 P11

Toeplitz(4) and Toeplitz(5)

Toeplitz(4) and Toeplitz(5) follow the same pattern as Toeplitz(2) and Toeplitz(3), but with the corresponding

numbers of bands.
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Banded(2)
Homogeneous Heterogeneous Correlation
g? pio? of  p1010; 1 p
pio? 0%  po’ P10207 o} P10203 pr 1 py
pio?  0?  pio p10303 a3 P10304 pr 1
pi0? o2 p10403  OF P1
Note: This is the same as Toeplitz(2).
Banded(3)
Homogeneous Heterogeneous Correlation
o* po* po? of p0103 pPO103 1 p p
po? d* po? po201 o3 p0O203  PO204 p 1 p p
pa? paz 02 pa pO30, pPO30, O  po30, p p 1 p
pa? pOLO, pPO4O3  OF p p 1

Banded(4) and Banded (5)
Banded(4) and Banded(5) follow the same pattern as Banded(2) and Banded(3), but with the corresponding

numbers of bands.

Unstructured
Homogeneous Heterogeneous Correla
2 2 2 2 o? 0,0 0,0 0,40,
a P120~  pP130 P140 1 P120102 P130103  P140104 1
2 2 2 2
P210 g P230 .0240 P210201 ) P230203  P240204 P21
2 2 2 2
P310°  P320 o .034J p310301  P320303 03 P340304 P31
2 2 2
P1102  Pgp0”  pyzo? P410401 P420402 P430403 04 Pa1

Partitioning the Variance-Covariance Structure with Groups

NCSS.com

P1
1

tion

P12 P13 P14
1 pa3 p2a

P32 1 p3a

Paz Paz 1

In the case where it is expected that the variance-covariance parameters are different across group levels of
the data, it may be useful to specify a different set of R or G parameters for each level of a group variable.
This produces a set of variance-covariance parameters that is different for each level of the chosen group
variable, but each set has the same structure as the other groups.

Partitioning the G Matrix Parameters

Suppose the structure of G is specified to be diagonal. If Gy, has four parameters, then
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If there are twenty subjects, then

The total number of variance parameters is four.

Suppose now that there are two groups of ten subjects, and it is believed that the four variance parameters
of the first group are different from the four variance parameters of the second group.

We now have

with eight variance parameters, rather than four.

Partitioning the R Matrix Parameters

Suppose the structure of R in a study with four time points is specified to be Toeplitz:

2 2 2
o P10~ pP20" P30

2 2 2
P10 o P10~ P20
2 2 2 I

p20%  p10 o p10
p30% po* pio?  o?

2

If there are sixteen subjects, then

R, 0 0 0
0 R, 0 0
R=|0 0o R, 0
0 0 0 Ry
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The total number of variance-covariance parameters is four: a2, p;, p, and ps.

Suppose now that there are two groups of eight subjects, and it is believed that the four variance
parameters of the first group are different from the four variance parameters of the second group.

We now have

2 2 2 2
01 P11~  P120~ P130
2 2 2 2
R R p110 01 P110~  P120
1, g 2 2 2 2 )
P120°  P110 01 P110
2 2 2 2
P130°  P120°  pP110 01
and
2 2 2 2
%) P210°  P2207 P30
2 2 2 2
R Rir = P210 ) P210°  P220
9, ", K16 = .

2 2 2 2

P220"  P210 ) P210

2 2 2 2
P230°  P2207 P10 03

The total number of variance-covariance parameters is now eight.

It is easy to see how quickly the number of variance-covariance parameters increases when R or Gis
partitioned by groups.

Repeated Measures Complication in Partitioning R

When partitioning the variance-covariance parameters into groups in some less-common repeated-
measures designs, more than one group can occur within a subject. Re-examining the R partitioning
example above, suppose instead that all sixteen subjects are measured four times: twice with Treatment A,
and twice with Treatment B. For the sake of this example, assume that the first eight subjects receive A, A, B,
B and the second eight receive B, B, A, A. The covariance parameters across treatments but within a subject
are assumed to be zero, and the R sub-matrices for the first eight subjects become

2 2
0x  PAOA
2 2
R R. = PaOA  Ox
1, """ ,Rg — 2 2 b
0  PBOB
2 2
PBOB OB
and for the last eight subjects,
2
OB PBOB
2
_ | PBOB OB
Ry, Rig = ) , |-
Ox  PA%A
2 2
PAOx  Op

The total number of variance-covariance parameters is only four: 62, a3, pa, and pg.

In general, when we attempt to divide the variance-covariance parameters into groups with a repeated-
measures design, the covariance of residuals within a subject, but across treatments, is assumed to be zero.
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Estimating and Testing Fixed Effects Parameters

The estimation phase in the analysis of a mixed model produces variance and covariance parameter
estimates of the elements of G and R, giving R and G, and hence, V. The REML and ML solutions for B are
given by

B=(XVX) 'XVly
with estimated variance-covariance
£ =var(B) = (XV1X)"

See, for example, Brown and Prescott (2006), Muller and Stewart (2006), or Demidenko (2004) for more
details of the estimating equations.

Hypothesis tests and confidence intervals for  are formed using a linear combination matrix (or vector) L.

L Matrix Details

L matrices specify linear combinations of B corresponding to means or hypothesis tests of interest.
Essentially, the L matrix defines the mean or test. The number of columns in each L matrix is the same as
the number of elements of B. For estimating a particular mean, the L matrix consists of a single row. For
hypothesis tests, the number of rows of L varies according to the test. Below are some examples of L
matrices that arise in common analyses:

L Matrix for Testing a Single Factor (Food with 4 levels) in a Single-Factor Model

No. Effect Food L1 L2 L3

1 Intercept

2 Food Highlron 1.0000 1.0000 1.0000
3 Food Lowlron -1.0000

4 Food None -1.0000

5 Food Salicyl -1.0000

L Matrix for a Single Mean (Lowlron) of a Single Factor (4 levels) in a Single-Factor
Model

No. Effect Food L1

1 Intercept 1.0000
2 Food Highlron

3 Food Lowlron 1.0000
4 Food None

5 Food Salicyl
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L Matrix for Testing a Single Factor (Drug - 3 levels) in a Two-Factor Model with

Interaction

No.  Effect

1 Intercept
2 Drug

3 Drug

4 Drug

5 Time

6 Time

7 Time

8 Time

9 Time

10 Time

11 Drug*Time
12 Drug*Time
13 Drug*Time
14 Drug*Time
15 Drug*Time
16 Drug*Time
17 Drug*Time
18 Drug*Time
19 Drug*Time
20 Drug*Time
21 Drug*Time
22 Drug*Time
23 Drug*Time
24 Drug*Time
25 Drug*Time
26 Drug*Time
27 Drug*Time
28 Drug*Time

Drug

Kerlosin
Laposec
Placebo

Kerlosin
Kerlosin
Kerlosin
Kerlosin
Kerlosin
Kerlosin
Laposec
Laposec
Laposec
Laposec
Laposec
Laposec
Placebo
Placebo
Placebo
Placebo
Placebo
Placebo

Time

0.5

1.5

25

0.5

1.5

2.5

0.5

1.5

2.5

0.5

1.5

2.5

L1

1.0000
-1.0000

0.1667
0.1667
0.1667
0.1667
0.1667
0.1667
-0.1667
-0.1667
-0.1667
-0.1667
-0.1667
-0.1667

L2

1.0000

-1.0000

0.1667
0.1667
0.1667
0.1667
0.1667
0.1667

-0.1667
-0.1667
-0.1667
-0.1667
-0.1667
-0.1667

L Matrix for Testing a Covariate in a One-Factor (3 levels) Model with a Covariate

z
°

coNOUT B~ WN —

Effect
Intercept
Drug

Drug

Drug

Weight
Drug*Weight
Drug*Weight
Drug*Weight

Drug

Kerlosin
Laposec
Placebo

Kerlosin
Laposec
Placebo

L1

1.0000
0.3333
0.3333
0.3333
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Kenward and Roger Fixed Effects Hypothesis Tests
Hypothesis tests have the general form
Hy:LB =0

where L is a linear contrast matrix of rank h corresponding to the desired comparisons to be made in the
hypothesis test. Let d be the denominator degrees of freedom and g be the number of variance-covariance
parameters, which is the dimension of W (defined below).

The Kenward and Roger (1997) test statistic for testing H, is
A _
Fha=7 B'L'(LC'L)'LB
where
qa q 1
C=C+2C Z Z W,S(Qrs— P,.CP — ZS”> C
r=1s=1
c=Xx'vix)1?

N
Q. =X'VIVVIVVIX = Z Xvv, viv, vix,

i=1

N
P, = -X'VIVvix=— Z XiVi' V. Vi'X;
i=1

N

S, =XV W VX = 2 XV, X,
i=1

W=H"1

{H},, = {Hessian }

_av

" do,

0%V
o, do;

rs

T =L (LCL)~1L

q q
a, = Z W, tr(TCP,C) tr( TCP,C)
=1s=1

r
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qa q
a, = 2 Z W, tr( TCP,CTCP,C)
r=1s=1

a, + 6a,
%= "o
e—(l—r)

_2{ 1+ ca3 }
YT h = cza2)2(1 — c3a5)
i 9
17 3n+2(1-9)

_ h-g
2T 3ht200—g)

_ h+2-g
ST 3ht200-g)

v
€4 = 2¢2
_ (h + 1)a1 - (h + 4')(12
(h+2)a2
d=4+ h+2

- C4h—1
1= d

T e(d-2)

Kenward and Roger Fixed Effects Confidence Intervals

Confidence intervals for linear combinations of B are formed as
LB * ty, 42 VLCL

where t,; o/, is the 1 — a/2 percentile of the t distribution with m degrees of freedom, with C, L, and m
defined above.
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Solution Algorithms

Methods for Finding Likelihood Solutions (Newton-Raphson, Fisher
Scoring, MIVQUE, and Differential Evolution)

There are four techniques in the Mixed Models procedure for determining the maximum likelihood or
restricted maximum likelihood solution (optimum): Newton-Raphson, Fisher Scoring, MIVQUE, and
Differential Evolution.

The general steps for the Newton-Raphson, Fisher Scoring, and Differential Evolution techniques are (let 0
be the overall covariance parameter vector):

1. Roughly estimate 0 according to the specified structure for each.
2. Evaluate the likelihood of the model given the data and the estimates of 0.

3. Improve upon the estimates of @ using a search algorithm. (Improvement is defined as an increase
in likelihood.)

4. Iterate until maximum likelihood is reached, according to some convergence criterion.

5. Use the final @ estimates to estimate f8.

Newton-Raphson and Fisher Scoring

The differences in the techniques revolve around the initial estimates in Step 1, and the improvements in
estimates made in Step 3. For the Newton-Raphson and Fisher Scoring techniques, Step 3 occurs as follows:

3a. With the estimated 8, compute the gradient vector g, and the Hessian matrix H.
3b. Computed = —H 1g.

3c. LetA =1.

3d. Compute new estimates for 0, iteratively, using ©; = 0;_; + Ad.

3e. If O; is a valid set of covariance parameters and improves the likelihood, continue to 3f. Otherwise,
reduce 1 by half and return to Step 3d.

3f. Check for convergence. If the convergence criteria (small change in -2log-likelihood) are met, stop. If
the convergence criteria are not met, go back to Step 3a.
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The gradient vector g, and the Hessian matrix H, used for the Newton-Raphson and Fisher Scoring
techniques for solving the REML equations are shown in the following table:

REML Gradient (g) and Hessian (H)

Technique Gradient (g) Hessian (H)
Newton-Raphson | g1+ g, + g3 H: + H> + Hs
Fisher Scoring gitg+8gs -H, + H3

The gradient vector g, and the Hessian matrix H, used for the Newton-Raphson and Fisher Scoring
techniques for solving the ML equations are shown in the following table:

ML Gradient (g) and Hessian (H)

Gradient (g) Hessian (H)

Newton-Raphson | g1 +8> H: + H;

Technique

Fisher Scoring g +8g -H;

where g1, 82, 83, H1, Hy, and Hs are defined as in Wolfinger, Tobias, and Sall (1994).

Definitions
N N
ov; .. 0%V, - R .
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X" =XK, KK = (X'VIX)"
Likelihoods
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1 IO, 1
ll =§Zln|Vl|, 12 =Ezeivi el‘, 13 =Eln
i=1 i=1

First Derivatives
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N
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N
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Second Derivatives

921 1 . . .
Hy = m = _EZ{tr(vi—lvrsi) — tr(V7 IV V) )
i=

o2, 1 ,
—_ 2 _—(grs_ r'ygs
2rs — aarao_s 2 (HZ 2H2 HZ)
2
Has = =2 =~ tr(HE' — H{H3)
S 90,00, 2

See Wolfinger, Tobias, and Sall (1994), page 1299, for details.

MIVQUE

The MIVQUE estimates of 8 in REML estimation are found by solving
—(H; + H3)0 = —g,.
The MIVQUE estimates of 8 in ML estimation are found by solving
—H,0 = —g,.

See Wolfinger, Tobias, and Sall (1994), page 1306, for details.

Differential Evolution

NCSS.com

The differential evolution techniques used in the Mixed Models procedure for the ML and REML

optimization are described in Price, Storn, and Lampinen (2005).
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Example 1 - Longitudinal Design (One Between-Subject
Factor, One Within-Subject Factor, One Covariate)

This example has two purposes:

1. Acquaint the reader with the output for all output options. In only this example, each heading of
each section of the output is described in detail.

2. Describe a typical analysis of a longitudinal design. A portion of this example involves the
comparison of options for the Repeated Variance Pattern. There is some discussion as the output is
presented and annotated, with a fuller discussion of model refinement and covariance options at
the end of this example.

In a longitudinal design, subjects are measured more than once, usually over time. This example presents
the analysis of a longitudinal design in which there is one between-subjects factor, one within-subjects
factor (Time), and a covariate. Two drugs (Kerlosin and Laposec) are compared to a placebo for their
effectiveness in reducing pain following a surgical eye procedure. A standard pain measurement for each
patient is measured at 30 minute intervals following surgery and administration of the drug (or placebo). Six
measurements, with the last at Time = 3 hours, are made for each of the 21 patients (7 per group). A blood
pressure measurement of each individual at the time of pain measurement is measured as a covariate. The
researchers wish to compare the drugs at the covariate value of 140.

Pain Dataset

Drug | Patient | Time | Cov | Pain
Kerlosin | 1 0.5 125 | 68
Kerlosin | 1 1 196 | 67
Kerlosin | 1 1.5 189 | 61
Kerlosin | 1 2 135 | 57
Kerlosin | 1 2.5 128 | 43
Kerlosin | 1 3 151 | 37
Kerlosin | 2 0.5 215 | 75
Kerlosin | 2 1 151 | 68
Kerlosin | 2 1.5 191 | 62
Kerlosin | 2 2 212 | 47
Kerlosin | 2 2.5 127 | 46
Kerlosin | 2 3 133 | 42
Placebo | 21 2 129 | 73
Placebo | 21 2.5 216 | 68
Placebo | 21 3 158 | 70
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The following plot shows the relationship among all variables except the covariate.

Pain

Pain vs Time by Drug
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60

40 4
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Time

Setup

To run this example, complete the following steps:

1 Open the Pain example dataset

From the File menu of the NCSS Data window, select Open Example Data.
Select Pain and click OK.

2 Specify the Mixed Models - General procedure options

Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

The settings for this example are listed below and are stored in the Example 1 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File
menu.

Variables Tab

Response Variable

Subject Variable............cccoveiiiiiiiiiiiie e

Repeated (Time) Variable..............c.cccoonnieeee. Time

Factor (Categorical) Variables ............... ...Drug,Time

Covariate (Continuous) Variables Cov

Fixed Effects Model ...........cccooiiiiiiiiiiiiiee. Drug Time Drug*Time Cov Drug*Cov Time*Cov Drug*Time*Cov

Random Model (Subject Terms Only) Patient

Covariates Tab

Covariate Variable 1 ..........c.cc.cccecveeenee. ...Cov
Compute Means at these Values 140
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Factor Variable 1 ..........cccccooiiiiiee DRUG
COMPATISON ....vivviiieiiee st a e All Pairs
Factor Variable 2 ..........cccccoviiiiiiiiic TIME
COMPATISON ... Baseline vs Each
Baseline........cocceeiiiiiiiiiie e 0.5

Reports Tab

RUN SUMMAIY ..ot Checked
Variance EStimates..........cccceveeiiiiiiiiieneeenies Checked
Hypothesis Tests.............. ...Checked

L Matrices - TermS.........oeeveeeiiiiiiiieeeeee e Checked
Comparisons by Fixed Effects.........cccccccceenie Checked
Comparisons by Covariate Values ...Checked

L Matrices - Comparisons...........cccceeeeeeeiuueiennn. Unchecked
Means by Fixed Effects .........ccccvvevieiiiiiinnnnnn. Checked
Means by Covariate Values...........c.ccccoeeunneen. Checked

L Matrices - LS MeansS...........cccuvveeeeeeeiiiiiiennn. Unchecked
Fixed Effects Solution...........cccccevvieeeiniieennnee. Checked
Asymptotic VC MatriX .........ceeeeeeeiiiiiiiieneeenais Checked

Vi Matrices (1st 3 SUbjects) .........ccccvvveeeeerinns Checked
Hessian MatriX........cccceevvvveiiiieeeiiiiee e Checked

3 Run the procedure

Click the Run button to perform the calculations and generate the output.

Run Summary Section

Run Summary Section

Iltem

Value

Likelihood Type
Fixed Model

Random Model
Repeated Pattern

Number of Rows
Number of Subjects

Solution Type
Fisher lterations
Newton lterations
Max Retries
Lambda

Log-Likelihood
-2 Log-Likelihood
AIC (Smaller Better)

Restricted Maximum Likelihood

DRUG+TIME+COV+DRUG*TIME+DRUG*COV+TIME*COV+
DRUG*TIME*COV

PATIENT

Diagonal

126
21

Newton-Raphson
3 of a possible 5
1 of a possible 40
10

1

-369.1552

738.3104
742.3104
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Convergence Normal
Run Time (Seconds) 0.867

This section provides a summary of the model and the iterations toward the maximum log likelihood.

Likelihood Type

This value indicates that restricted maximum likelihood was used rather than maximum likelihood.

Fixed Model

The model shown is that entered as the Fixed Factors Model of the Variables tab. The model includes fixed
terms and covariates.

Random Model

The model shown is that entered as the Random Factors Model of the Variables tab.

Repeated Model

The pattern shown is that entered as the Repeated (Time) Variance Pattern of the Variables tab.

Number of Rows

The number of rows processed from the database.

Number of Subjects

The number of unique subjects from the database.

Solution Type

The solution type is method used for finding the maximum (restricted) maximum likelihood solution.
Newton-Raphson is the recommended method.

Fisher Iterations

Some Fisher-Scoring iterations are used as part of the Newton-Raphson algorithm. The ‘4 of a possible 10’
means four Fisher-Scoring iterations were used, while ten was the maximum that were allowed (as specified
on the Maximization tab).

Newton Iterations
The "1 of a possible 40’ means one Newton-Raphson iteration was used, while forty was the maximum
allowed (as specified on the Maximization tab).

Max Retries

The maximum number of times that lambda was changed and new variance-covariance parameters found
during an iteration was ten. If the values of the parameters result in a negative variance, lambda is divided
by two and new parameters are generated. This process continues until a positive variance occurs or until
Max Retries is reached.
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Lambda

Lambda is a parameter used in the Newton-Raphson process to specify the amount of change in parameter
estimates between iterations. One is generally an appropriate selection. When convergence problems occur,
reset this to 0.5.

If the values of the parameters result in a negative variance, lambda is divided by two and new parameters
are generated. This process continues until a positive variance occurs or until Max Retries is reached.

Log Likelihood

This is the log of the likelihood of the data given the variance-covariance parameter estimates. When a
maximum is reached, the algorithm converges.

-2 Log Likelihood

This is minus 2 times the log of the likelihood. When a minimum is reached, the algorithm converges.

AIC

The Akaike Information Criterion is used for comparing covariance structures in models. It gives a penalty
for increasing the number of covariance parameters in the model.

Convergence

‘Normal’ convergence indicates that convergence was reached before the limit.

Run Time (Seconds)

The run time is the amount of time used to solve the problem and generate the output.

Random Component Parameter Estimates (G Matrix)

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 1.6343 Patient

This section gives the random component estimates according to the Random Factors Model specifications
of the Variables tab.

Component Number

A number is assigned to each random component. The first component is the one specified on the variables
tab. Components 2-5 are specified on the More Models tab.

Parameter Number

When the random component model results in more than one parameter for the component, the
parameter number identifies parameters within the component.
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Estimated Value

The estimated value 1.6343 is the estimated patient variance component.

Model Term

Patient is the name of the random term being estimated.

Repeated Component Parameter Estimates (R Matrix)

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 23.5867 Diagonal (Variance)

This section gives the repeated component estimates according to the Repeated Variance Pattern
specifications of the Variables tab.

Component Number

A number is assigned to each repeated component. The first component is the one specified on the
variables tab. Components 2-5 are specified on the More Models tab.

Parameter Number

When the repeated pattern results in more than one parameter for the component, the parameter number
identifies parameters within the component.

Estimated Value

The estimated value 23.5867 is the estimated residual (error) variance.

Parameter Type

The parameter type describes the structure of the R matrix that is estimated, and is specified by the
Repeated Component Pattern of the Variables tab.
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Term-by-Term Hypothesis Test Results

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Drug 1.8217 2 89.0 0.167729
Time 0.9780 5 88.4 0.435775
Cov 3.3021 1 87.1 0.072631
Drug*Time 0.8627 10 87.0 0.570795
Drug*Cov 0.7698 2 86.8 0.466228
Time*Cov 1.2171 5 88.5 0.307773
Drug*Time*Cov 1.0691 10 87.0 0.394694

These F-Values test Type-Ill (adjusted last) hypotheses.

This section contains a F-test for each component of the Fixed Component Model according to the methods
described by Kenward and Roger (1997).

Model Term

This is the name of the term in the model.

F-Value

The F-Value corresponds to the L matrix used for testing this term in the model. The F-Value is based on the
F approximation described in Kenward and Roger (1997).

Num DF

This is the numerator degrees of freedom for the corresponding term.

Denom DF

This is the approximate denominator degrees of freedom for this comparison as described in Kenward and
Roger (1997).

Prob Level

The Probability Level (or P-value) gives the strength of evidence (smaller Prob Level implies more evidence)
that a term in the model has differences among its levels, or a slope different from zero in the case of
covariate. It is the probability of obtaining the corresponding F-Value (or greater) if the null hypothesis of
equal means (or no slope) is true.
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Individual Comparison Hypothesis Test Results

Individual Comparison Hypothesis Test Results by Covariate Values

Covariates: Cov = 140.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference  F-Value DF DF Level Level
Drug
Drug 43.1757 2 32.8 0.000000
Drug: Kerlosin - Laposec -3.4655 4.2279 1 37.7 0.046734  0.140202 [3]
Drug: Kerlosin - Placebo -13.5972  78.7500 1 28.9 0.000000 0.000000 [3]
Drug: Laposec - Placebo -10.1316  39.4701 1 33.8 0.000000 0.000001 [3]
Time
Time 46.5094 5| 82.3 0.000000
Time: 0.5-1 2.8138 1.3602 1 87.0 0.246695  1.000000 [5]
Time: 0.5-1.5 8.1935 20.2334 1 82.7 0.000022 0.000111 [5]
Time: 0.5-2 11.2966  29.2190 1 79.6 0.000001 0.000003 [5]
Time: 0.5-2.5 21.2629 122.1178 1 83.6 0.000000  0.000000 [5]
Time: 0.5-3 22.2608 152.6565 1 81.0 0.000000  0.000000 [5]
Drug*Time
Drug*Time 5.3797 10 81.1 0.000005
Drug = Kerlosin, Time: 0.5-1 7.0448 3.6965 1 86.3 0.057827 0.867407 [15]
Drug = Kerlosin, Time: 0.5-1.5 10.0459 9.4516 1 84.9 0.002837 0.042551 [15]
Drug = Kerlosin, Time: 0.5 - 2 19.7016  19.5674 1 77.8 0.000031 0.000467 [15]
Drug = Kerlosin, Time: 0.5 - 2.5 34.2896 118.8079 1 80.8 0.000000 0.000000 [15]

34.7612 116.1114 1 84.3 0.000000

Drug = Kerlosin, Time: 0.5 -3

0.000000 [15]

These F-Values test Type-Ill (adjusted last) hypotheses.

This section shows the F-tests for comparisons of the levels of the fixed terms of the model according to the
methods described by Kenward and Roger (1997). The individual comparisons are grouped into subsets of

the fixed model terms.

Comparison/Covariate(s)

This is the comparison being made. The first line is ‘Drug’. On this line, the levels of drug are compared
when the covariate is equal to 140. The second line is ‘Drug: Placebo - Kerlosin'. On this line, Kerlosin is
compared to Placebo when the covariate is equal to 140.

Comparison Mean Difference

This is the difference in the least squares means for each comparison.

F-Value

The F-Value corresponds to the L matrix used for testing this comparison. The F-Value is based on the F
approximation described in Kenward and Roger (1997).
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This is the numerator degrees of freedom for this comparison.

Denom DF
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This is the approximate denominator degrees of freedom for this comparison as described in Kenward and

Roger (1997).

Raw Prob Level

The Raw Probability Level (or Raw P-value) gives the strength of evidence for a single comparison,
unadjusted for multiple testing. It is the single test probability of obtaining the corresponding difference if

the null hypothesis of equal means is true.

Bonferroni Prob Level

The Bonferroni Prob Level is adjusted for multiple tests. The number of tests adjusted for is enclosed in
brackets following each Bonferroni Prob Level. For example, 0.8674 [15] signifies that the probability the

means are equal, given the data, is 0.8674, after adjusting for 15 tests.

Least Squares (Adjusted) Means

Least Squares (Adjusted) Means by Covariate Values

Covariates: Cov = 140.0000

95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 64.1132 0.6578 62.7756 65.4508 335
Drug
Kerlosin 58.4256 1.1375 56.1112 60.7400 329
Laposec 61.8912 1.2437 59.3819 64.4005 42.3
Placebo 72.0228 1.0266 69.9077 74.1380 24.8
Time
0.5 75.0845 1.3928 72.3172 77.8517 89.8
1 72.2707 1.9886 68.3199 76.2216 89.9
1.5 66.8910 1.2243 64.4584 69.3235 89.3
2 63.7879 1.6286 60.5523 67.0235 90.0
25 53.8216 1.3744 51.0909 56.5522 89.7
3 52.8237 1.2048 50.4299 55.2175 89.2
Drug*Time
Kerlosin, 0.5 76.0661 2.5993 70.9021 81.2302 89.8
Kerlosin, 1 69.0213 2.6391 63.7782 74.2644 90.0

This section gives the adjusted means for the levels of each fixed factor when Cov = 140.
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Name

This is the level of the fixed term that is estimated on the line.

Mean

The mean is the estimated least squares (adjusted or marginal) mean at the specified value of the covariate.

Standard Error of Mean

This is the standard error of the mean.

95.0% Lower (Upper) Conf. Limit for Mean

These limits give a 95% confidence interval for the mean.

DF

The degrees of freedom used for the confidence limits are calculated using the method of Kenward and
Roger (1997).

Means Plots
Means Plots
Means Plot of Pain Means Plot of Pain
Covariance Values: Cov = 140.0000 Covariance Values: Cov = 140.0000
80 80 -
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Means Plot of Pain by Time
Means Plot of Pain by Drug

Covariance Values: Cov = 140.0000
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These plots show the means broken up into the categories of the fixed effects of the model. Some general
trends that can be seen are those of pain decreasing with time and lower pain for the two drugs after two
hours.

Subject Plots

Subject Plots
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Pain vs Time by Time
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Each set of connected dots of the Subject plots show the repeated measurements on the same subject. The
second plot is perhaps the most telling, as it shows a separation of pain among drugs after 2 hours.

Solution for Fixed Effects

Solution for Fixed Effects

95.0% 95.0%
Effect Effect Lower Upper

Effect Estimate Standard Prob Conf. Limit Conf. Limit Effect
Name (Beta) Error Level of Beta of Beta DF No
Intercept 66.8296 7.4693 0.000000 51.9900 81.6692 89.8 1
(Drug="Kerlosin") -9.4849  11.9162 0.428154 -33.1595 14.1898 89.7 2
(Drug="Laposec") -16.5164 14.6176 0.261539 -45.5591 12.5264 89.5 3
(Drug="Placebo") 0.0000 0.0000 4
(Time=0.5) 23.0382 12.0137 0.058369 -0.8336 46.9099 88.8 5
(Time=1) -4.9520 10.5394 0.639641 -25.9029 15.9988 86.2 6
(Time=1.5) 16.5033 12.3512 0.184968 -8.0451 41.0518 87.2 7
(Time=2) 10.8739  14.7800 0.463980 -18.5236 40.2714 82.9 8
(Time=2.5) 3.0828 12.5528 0.806621 -21.8933 28.0589 81.0 9
(Time=3) 0.0000 0.0000 10
Cov -0.0089 0.0461 0.846662 -0.1004 0.0826 89.6 11
(Drug="Kerlosin")*(Time=0.5) -4.0793 17.5910 0.817159 -39.0401 30.8815 87.6 12
(Drug="Kerlosin")*(Time=1) 12,5535 17.5889 0.477371 -22.4218 47.5288 84.4 13
(Drug="Kerlosin")*(Time=1.5) 0.5047 16.9396 0.976299 -33.1511 34.1604 89.6 14
(Drug="Kerlosin")*(Time=2) -4.3550 22.4012 0.846297 -48.8635 40.1535 89.3 15

16

(Drug="Kerlosin")*(Time=2.5) 1.7025 20.5500 0.934174 -39.1709 42.5758 83.0

This section shows the model estimates for all the model terms (betas).

Effect No.

This number identifies the effect of the line.
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Effect Name

The Effect Name is the level of the fixed effect that is examine on the line.

Effect Estimate (Beta)

The Effect Estimate is the beta-coefficient for this effect of the model. For main effects terms the number of
effects per term is the number of levels minus one. An effect estimate of zero is given for the last effect(s) of
each term. There may be several zero estimates for effects of interaction terms.

Effect Standard Error

This is the standard error for the corresponding effect.

Prob Level

The Prob Level tests whether the effect is zero.

95.0% Lower (Upper) Conf. Limit of Beta

These limits give a 95% confidence interval for the effect.

DF

The degrees of freedom used for the confidence limits and hypothesis tests are calculated using the method
of Kenward and Roger (1997).

Asymptotic Variance-Covariance Matrix of Variance Estimates

Asymptotic Variance-Covariance Matrix of Variance Estimates

Parameter G(1,1) R(1,1)
G(1,1) 4.5645 -2.6362
R(1,1) -2.6362 15.0707

This section gives the asymptotic variance-covariance matrix of the variance components of the model.
Here, the variance of the Patient variance component is 4.5645. The variance of the residual variance is
15.0707.

Parm

Parm is the heading for both the row variance parameters and column variance parameters.

G(1,1)

The two elements of G(1,1) refer to the component number and parameter number of the covariance
parameter in G.

R(1,1)

The two elements of R(1,1) refer to the component number and parameter number of the covariance
parameter in R.
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Estimated Vi Matrix of Subject = X

Estimated Vi Matrix of Subject = 1

Vi 1 2 3 4 5 6
1 25.2210 1.6343 1.6343 1.6343 1.6343 1.6343
2 1.6343 25.2210 1.6343 1.6343 1.6343 1.6343
3 1.6343 1.6343 25.2210 1.6343 1.6343 1.6343
4 1.6343 1.6343 1.6343 25.2210 1.6343 1.6343
5 1.6343 1.6343 1.6343 1.6343 25.2210 1.6343
6 1.6343 1.6343 1.6343 1.6343 1.6343 25.2210
Estimated Vi Matrix of Subject = 2

Vi 1 2 3 4 5 6
1 25.2210 1.6343 1.6343 1.6343 1.6343 1.6343
2 1.6343 25.2210 1.6343 1.6343 1.6343 1.6343
3 1.6343 1.6343 25.2210 1.6343 1.6343 1.6343
4 1.6343 1.6343 1.6343 25.2210 1.6343 1.6343
5 1.6343 1.6343 1.6343 1.6343 25.2210 1.6343
6 1.6343 1.6343 1.6343 1.6343 1.6343 25.2210
Estimated Vi Matrix of Subject =3

Vi 1 2 3 4 5 6
1 25.2210 1.6343 1.6343 1.6343 1.6343 1.6343
2 1.6343 25.2210 1.6343 1.6343 1.6343 1.6343
3 1.6343 1.6343 25.2210 1.6343 1.6343 1.6343
4 1.6343 1.6343 1.6343 25.2210 1.6343 1.6343
5 1.6343 1.6343 1.6343 1.6343 25.2210 1.6343
6 1.6343 1.6343 1.6343 1.6343 1.6343 25.2210

This section gives the estimated variance-covariance matrix for each of the first three subjects.

1-6

Each of the 6 levels shown here represents one of the time values. That is 1 is for 0.5 hours, 2 is for 1 hour, 3
is for 1.5 hours, and so on. The number 25.2210 is calculated by adding the two variance estimates together,

1.6343 + 23.5867 = 25.2210.
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Hessian Matrix of Variance Estimates

Hessian Matrix of Variance Estimates

Parameter G(1,2) R(1,1)

G(1,1) 0.2437  0.0426
R(1,1) 0.0426  0.0738

The Hessian Matrix is directly related to the asymptotic variance-covariance matrix of the variance
estimates.

Parm

Parm is the heading for both the row variance parameters and column variance parameters.

G(1,1)

The two elements of G(1,1) refer to the component number and parameter number of the covariance
parameter in G.

R(1,1)

The two elements of R(1,1) refer to the component number and parameter number of the covariance
parameter in R.

L Matrices

L Matrix for Drug

No. Effect Drug Time L1 L2

1 Intercept

2 Drug Kerlosin 1.0000 1.0000
3 Drug Laposec -1.0000

4 Drug Placebo -1.0000
5 Time 0.5

6 Time 1

7 Time 15

8 Time 2

9 Time 25

10 Time 3

11 Cov

12 Drug*Time Kerlosin 0.5 0.1667 0.1667
13 Drug*Time Kerlosin 1 0.1667 0.1667
14 Drug*Time Kerlosin 15 0.1667 0.1667
15 Drug*Time Kerlosin 2 0.1667 0.1667
16 Drug*Time Kerlosin 25 0.1667 0.1667

17 Drug*Time Kerlosin 3 0.1667 0.1667

(report continues with several pages of output)
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The L matrices are used to form a linear combination of the betas corresponding to a specific hypothesis
test or mean estimate. The L matrix in this example is used for testing whether there is a difference among
the three levels of Drug.

No.

This number is used for identifying the corresponding beta term.

Effect

This column gives the model term.

Factor Variables (e.g. Drug, Time)

These columns identify the level of each fixed effect to which the coefficients of the L matrix of the same line
correspond.

L1, L2, L3, ...

L1, L2, L3, ... are a group of column vectors that combine to form an L matrix. The L matrix in this example is
used for testing whether there is a difference among the three levels of Drug.

Discussion of Example 1 Results

The output shown for this example to this point has been for the full model with all interactions. It has been
shown to illustrate the several sections of output that are available. In practice, when dealing with
covariates, this model should be refined before making conclusions concerning the two drugs in question.
The original F-test results are repeated below.

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Drug 1.8217 2 89.0 0.167729
Time 0.9780 5 88.4 0.435775
Cov 3.3021 1 87.1 0.072631
Drug*Time 0.8627 10 87.0 0.570795
Drug*Cov 0.7698 2 86.8 0.466228
Time*Cov 1.2171 5 88.5 0.307773
Drug*Time*Cov 1.0691 10 87.0 0.394694

These F-Values test Type-lll (adjusted last) hypotheses.

Using a hierarchical step-down approach to model improvement, we begin by removing the highest order
term, the three-way interaction (F-Value = 1.07, Prob Level = 0.3947). The F-test results for this new model
are as follows:
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Term-by-Term Hypothesis Test Results
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Model Num Denom Prob
Term F-Value DF DF Level
Drug 4.1700 2 96.8 0.018315
Time 1.3419 5 98.0 0.253118
Cov 1.7686 1 98.9 0.186615
Drug*Time 7.4394 10 84.1 0.000000
Drug*Cov 2.2336 2 92.4 0.112895
Time*Cov 2.3667 5 98.0 0.045036

These F-Values test Type-Ill (adjusted last) hypotheses.

Since all interaction Prob Levels are now quite small, this model appears to be reasonable. Some
researchers might argue to continue refinement by removing the Drug*Cov interaction (F-Value = 2.23, Prob
Level =0.1129). Such an argument is also reasonable, but this is not the course that is pursued here, since a
moderately low prob level indicates there may be a mild Drug*Cov interaction effect.

The dominant prob level is the one associated with the Drug*Time interaction (F-Value = 7.44, Prob Level =
0.0000). This interaction can be clearly seen in the following scatter plot of the individual subjects. Note that

the Placebo group does not decrease as rapidly as the Kerlosin group.

Subject Plots

Pain vs Time by Drug
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This interaction can be examined in greater detail by comparing the three levels of Drug at each time point
(at the covariate value of 140).
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Covariates: Cov = 140.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference  F-Value DF DF Level Level
Drug*Time
Time = 0.5, Drug: Kerlosin - Laposec 6.1619 4.3285 1 100.0 0.040036 0.720656 [18]
Time = 0.5, Drug: Kerlosin - Placebo -1.0451 0.1287 1 100.0 0.720543 1.000000 [18]
Time = 0.5, Drug: Laposec - Placebo -7.2070 6.3717 1 100.0 0.013169 0.237046 [18]
Time = 1, Drug: Kerlosin - Laposec 1.4659 0.2530 1 100.0 0.616068 1.000000 [18]
Time = 1, Drug: Kerlosin - Placebo -7.2872 6.2095 1 99.9 0.014353 0.258346 [18]
Time = 1, Drug: Laposec - Placebo -8.7531 8.1482 1 100.0 0.005241 0.094336 [18]
Time = 1.5, Drug: Kerlosin - Laposec 2.3523 0.7185 1 99.9 0.398661 1.000000 [18]
Time = 1.5, Drug: Kerlosin - Placebo -5.2756 3.6844 1 99.8 0.057780 1.000000 [18]
Time = 1.5, Drug: Laposec - Placebo -7.6278 7.5730 1 99.9 0.007037 0.126669 [18]
Time = 2, Drug: Kerlosin - Laposec -2.4751 0.6341 1 100.0 0.427746 1.000000 [18]
Time = 2, Drug: Kerlosin - Placebo -14.1184  19.4393 1 100.0 0.000026 0.000471 [18]
Time = 2, Drug: Laposec - Placebo -11.6433  17.6388 1 99.8 0.000058 0.001046 [18]
Time = 2.5, Drug: Kerlosin - Laposec -11.0499  16.5687 1 99.7 0.000094 0.001693[18]
Time = 2.5, Drug: Kerlosin - Placebo -27.1071  70.0980 1 100.0 0.000000 0.000000 [18]
Time = 2.5, Drug: Laposec - Placebo -16.0572  26.3720 1 100.0 0.000001 0.000025 [18]
Time = 3, Drug: Kerlosin - Laposec -10.7977  15.6495 1 99.8 0.000143 0.002569 [18]
Time = 3, Drug: Kerlosin - Placebo -25.1938  84.9230 1 99.8 0.000000 0.000000 [18]
Time = 3, Drug: Laposec - Placebo -14.3960  27.5367 1 99.8 0.000001 0.000016 [18]

These F-Values test Type-lll (adjusted last) hypotheses.

The first Bonferroni-adjusted significant difference among levels of treatment occurs at Time = 2 hours. At
Time = 2, the Kerlosin and Laposec means are significantly different from the Placebo mean (Bonferroni
Prob Levels = 0.0005 and 0.0010, respectively), but not from each other (Bonferroni Prob Level = 1.0000). At
times 2.5 hours and 3 hours all levels of Drug are significantly different, with Kerlosin showing the greatest

pain reduction.

Repeated and Random Component Specification

Another issue that should be considered from the beginning of the analysis is the covariance structure of
the repeated measurements over time. The specification to this point involved both random (G) and the
repeated (R) components of the model. The G and the R matrices are used to form the complete variance-
covariance matrix of all the responses using the formula V = ZGZ' + R. The R and the R used to this point

have the form

where G has dimension 21 by 21 and R has dimension 126 by 126. The resulting variance-covariance matrix,

V = ZGZ' + R, has the form
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where each 6 by 6 block corresponds to a single patient. The full dimension of this matrix is 6*21 = 126 by

126.

The estimates of ¢ and a2 for the model without the three-way interaction are 0.7066 and 24.6293, as

shown in the output below.

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 0.7066 Patient

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 24.6293 Diagonal (Variance)

The resulting 6 by 6 matrix for each subject (as shown in the output) is

Estimated Vi Matrix of Subject = 1

Vi 1 2 3 4 5 6
1 25.3359 0.7066 0.7066 0.7066 0.7066 0.7066
2 0.7066 25.3359 0.7066 0.7066 0.7066 0.7066
3 0.7066 0.7066 25.3359 0.7066 0.7066 0.7066
4 0.7066 0.7066 0.7066 25.3359 0.7066 0.7066
5 0.7066 0.7066 0.7066 0.7066 25.3359 0.7066
6 0.7066 0.7066 0.7066 0.7066 0.7066 25.3359

The number 25.3359 comes from adding 0.7066 and 24.6293.
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Using Compound Symmetry as the Repeated Pattern Rather than Using a Random Component

An alternative specification that yields the same results is to remove the Random Component of the Model
(Patient) and change the Repeated (Time) Covariance Pattern to Compound Symmetry with Force Covariances
to be Positive checked on the Maximization tab. In this case, there is no G matrix and the R matrix has the
form

o? po? po? po? po? po?

pa? o% po? po? po? po?

_ | po? po* 0% po? po? po?
R= 2 2 2 2 2 2
pa? po? po? 0% po? po

pa? po? po? po? o? po?

pa? po? po? po? po? o?

The true dimension of R is still 126 by 126 with 21 of the above matrices along the diagonal. The Repeated
Component output becomes

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter

Number Number Value Type

1 1 25.3358 Diagonal (Variance)

1 1 0.0279 Off-Diagonal (Correlation)

Here, the estimate of g2 is 25.3358 and the estimate of p is 0.0279.

The V matrix now has the form

o? po? po? po? po? po? 0 0
pa? o% po? po? po? po? 0 0
pa? po? ¢? po? po? po? 0 0
pa? po? po? o? po? po? 0 0
V=1ps? pc? po?® po? o?> po*? 0 0
pa? po? po? po? po? d®> 0 0

0 0 0 0 0 0 0% po?

and the estimated block for each subject using the compound symmetry specification is

Estimated Vi Matrix of Subject = 1

Vi 1 2 3 4 5 6
1 25.3358 0.7065 0.7065 0.7065 0.7065 0.7065
2 0.7065 25.3358 0.7065 0.7065 0.7065 0.7065
3 0.7065 0.7065 25.3358 0.7065 0.7065 0.7065
4 0.7065 0.7065 0.7065 25.3358 0.7065 0.7065
5 0.7065 0.7065 0.7065 0.7065 25.3358 0.7065
6 0.7065 0.7065 0.7065 0.7065 0.7065 25.3358
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which is identical (to rounding error) to the previous result using random and repeated component
specification.

Other Repeated Patterns (AR(1))

It is natural to expect that the covariances of measurements made closer together in time are more similar
than those at more distant times. Several covariance pattern structures have been developed for such
cases. A complete list of the available structures in the Mixed Models procedure is given elsewhere in the
chapter. Here, we will examine one of the more common structures: AR(1).

Using the AR(1) covariance pattern, there are only two parameters, 62 and p , but the coefficient of o'
decreases exponentially as observations are farther apart. The R matrix has the form

62 pa? pPa? p3c? pto? pSo?
pa? %  po? p2a? pio? pio?
p°a® p“oc® po o po“  pco
\p402 p3a2 p2a?  po? o2 paz/
p%a% pta? p3g? p2e? po? 0P

The true dimension of R is 126 by 126 with 21 of the above matrices along the diagonal.

The Repeated Component output becomes

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter

Number Number Value Type

1 1 25.3360 Diagonal (Variance)

1 1 0.0659 Off-Diagonal (Correlation)

Here, the estimate of o2 is 25.3360 and the estimate of p is 0.0659.

The estimated block for each subject using the AR(1) specification is

Estimated Vi Matrix of Subject = 1

Vi 1 2 3 4 5 6
1 25.3360 1.6696 0.1100 0.0073 0.0005 0.0000
2 1.6696 25.3360 1.6696 0.1100 0.0073 0.0005
3 0.1100 1.6696 25.3360 1.6696 0.1100 0.0073
4 0.0073 0.1100 1.6696 25.3360 1.6696 0.1100
5 0.0005 0.0073 0.1100 1.6696 25.3360 1.6696
6 0.0000 0.0005 0.0073 0.1100 1.6696 25.3360

The estimates of the covariance parameters using this formulation are closer to 0 as the time between
measurements increases.

The AIC value may be used to compare the various covariance structures. The AIC value for the AR(1)
specification is 725.77. The AIC value for the compound symmetry (and random component) specification is
725.94. A smaller AIC value indicates a better model. Thus, the AR(1) specification provides a slight
improvement over the compound symmetry (and random component) specification.
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Example 2a - Two-Sample T-Test Assuming Equal Variance
(One Between-Subject Factor, No Within-Subject Factors,
No Covariates)

Examples 2a and 2b show how the use of the Mixed Models procedure gives the same results as the
corresponding two-sided test in the Two-Sample T-Test procedure. Example 2c shows the extension to
include a covariate in a two-sample test, which cannot be done using the Two-Sample T-Test procedure.

One of the simplest, yet very commonly used, designs is the two-group design. In this design, subjects are
randomly assigned to, or randomly drawn from, one of two groups. A response is measured, and the means
are compared. The common technique for analysis in this scenario is the two-sample (two-group) T-test. The
data set-up for this design is two variables.

Two Sample Dataset

Response | Treatment
141 Treatment
146 Treatment
138 Treatment
155 Treatment
134 Treatment
136 Treatment
142 Treatment
137 Treatment
190 Placebo
186 Placebo
183 Placebo
175 Placebo

Using the T-Test - Two-Sample procedure, the two groups would be compared by entering Response as the
Response Variable and Treatment as the Group Variable. An excerpt of the output appears as follows.

Output Excerpt - Two-Sample T-Test Procedure

Equal-Variance T-Test

Alternative Mean Standard Prob Reject HO
Hypothesis Difference Error T-Statistic DF Level at a =0.05?
M1-p2#0 15.14474 5.763373 2.6278 33 0.01294 Yes

The equivalence of means is rejected (Prob Level = 0.01294) at the 0.05 alpha level.
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The corresponding analysis in the Mixed Models procedure is similar, but an additional subject variable
must be added. The subject variable identifies the subject to which each row belongs. When there are no
repeated measurements, a subject variable may be created quickly by clicking any cell in a blank variable,
selecting Fill from the Edit menu, and clicking on Fill.

Two-Sample T-Test Example Dataset - Two Sample 2

Response | Treatment | Subject
141 Treatment | 1
146 Treatment | 2
138 Treatment | 3
155 Treatment | 4
134 Treatment |5
136 Treatment | 6
142 Treatment | 7
137 Treatment | 8
190 Placebo 32
186 Placebo 33
183 Placebo 34
175 Placebo 35
Setup

To run this example, complete the following steps:

1 Open the Two Sample 2 example dataset
« From the File menu of the NCSS Data window, select Open Example Data.
o Select Two Sample 2 and click OK.

2 Specify the Mixed Models - General procedure options
« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 2a settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ..........cccccovvvevieiiiiiiiiienee, Response
Subject Variable............ccooiiiiiiie Subject
Repeated (Time) Variable................ccoouvveenenn. <Empty>
Factor (Categorical) Variables.............cccccee..... Treatment
Fixed Effects Model ........ccccoeeeiiiiiiiiiiiiiiiieeeen, Treatment
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3 Run the procedure

« Click the Run button to perform the calculations and generate the output.

Mixed Models - General

NCSS.com

Mixed Models Output

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 288.5088 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Treatment 6.9051 1 33.0 0.012941

These F-Values test Type-lll (adjusted last) hypotheses.

The Prob Level (0.0129) for the Treatment term is the same as the one given by the Two-Sample T-Test
procedure. The estimate of the residual variance is 288.5088, which is the square of the standard deviation

from the Two-Sample T-Test procedure.
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Example 2b - Two-Sample T-Test Assuming Unequal
Variance (One Between-Subject Factor, No Within-Subject
Factors, No Covariates)

We now examine the Two Sample dataset without assuming equal variance among the two groups. The
mean response is to be compared for a treatment and placebo.

Two Sample Dataset

Response | Treatment
141 Treatment
146 Treatment
138 Treatment
155 Treatment
134 Treatment
136 Treatment
142 Treatment
137 Treatment
190 Placebo
186 Placebo
183 Placebo
175 Placebo

The assumption of equal variance in this example is probably not a good one, as evidenced by the dot plot
and equal variance tests shown below. The dot plot is obtained using the Dot Plots procedure, while the
assumption tests are from the Two-Sample T-Test procedure.
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Dot Plots
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Tests of the Equal Variance Assumption

Reject HO of

Equal Variances
Equal-Variance Test Test Statistic Prob Level at a =0.05?
Variance-Ratio 7.4226 0.00030 Yes
Modified-Levene 11.8596 0.00158 Yes

The variance of the placebo group is much larger than that of the treatment group. The Aspin-Welch
Unequal-Variance T-test should be used in place of the traditional T-test. An equivalent option is allowing for
a separate variance for each group in the Mixed Models procedure.

Using the T-Test - Two-Sample procedure, the two groups would be compared by entering Response as the
Response Variable and Treatment as the Group Variable. An excerpt of the output appears as follows.

Unequal Variance Output Excerpt - Two-Sample T-Test Procedure

Aspin-Welch Unequal-Variance T-Test

Alternative Mean Standard Prob Reject HO
Hypothesis Difference Error T-Statistic DF Level at a =0.05?
M1-p2#0 15.14474 5.388208 2.8107 23.50 0.00980 Yes

The corresponding analysis in the Mixed Models procedure is similar, but an additional subject variable
must be added. The subject variable identifies the subject to which each row belongs. When there are no
repeated measurements, a subject variable may be created quickly by clicking any cell in a blank variable,
selecting Fill from the Edit menu, and clicking on Fill.
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Two-Sample T-Test Example Dataset - Two Sample 2
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Response | Treatment | Subject
141 Treatment | 1
146 Treatment | 2
138 Treatment | 3
155 Treatment | 4
134 Treatment |5
136 Treatment | 6
142 Treatment | 7
137 Treatment | 8
190 Placebo 32
186 Placebo 33
183 Placebo 34
175 Placebo 35
Setup

To run this example, complete the following steps:

1 Open the Two Sample 2 example dataset

2 Specify the Mixed Models - General procedure options

From the File menu of the NCSS Data window, select Open Example Data.

Select Two Sample 2 and click OK.

Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

The settings for this example are listed below and are stored in the Example 2b settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ..........ccoccvvieiie i, Response
Subject Variable............ccoiiiii e Subject
Repeated (Time) Variable..........c..cccoevvvviiiieeiininnns <Empty>
Factor (Categorical) Variables ...........cccccceveeeieiinnns Treatment
Fixed Effects Model ..., Treatment
Repeated (Time) Covariance Pattern Groups ........ Treatment

3 Run the procedure

Click the Run button to perform the calculations and generate the output.
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Mixed Models Output

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Group Estimated Parameter
Number Number Number Value Type

1 1 1 475.5439 Diagonal (Variance)
1 1 2 64.0667 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Treatment 7.9001 1 235 0.009801

These F-Values test Type-lll (adjusted last) hypotheses.

The Prob Level (0.0098) is the same as the one given by the Aspin-Welch Unequal Variance test of the Two-
Sample T-Test procedure. The two variance estimates, 475.5436 and 64.0666, correspond to the placebo
and treatment groups, respectively, and are the squares of the individual group standard deviations given in
the Two-Sample T-Test procedure.

Examples 2a and 2b would likely be run using the Two-Sample T-Test procedure rather than the Mixed
Models procedure. These examples are provided as an introduction to running the Mixed Models procedure
for a simple case, as well as to show the flexibility of the Mixed Models procedure. Example 2c shows the
extension of a two-sample test to the inclusion of a covariate. The Two-Sample T-Test procedure does not
permit the inclusion of a covariate.
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Example 2c - Two-Sample T-Test with a Covariate (One
Between-Subject Factor, No Within-Subject Factors, One
Covariate)

The two-sample analyses shown in Examples 2a and 2b would likely be carried out using the T-Test - Two-
Sample procedure rather than the Mixed Models procedure because the T-Test procedure is easier to use
and gives more specific output. However, when a covariate is measured for each subject there is no way to
incorporate this into a simple T-test. The analysis becomes analysis of covariance, or ANCOVA. The General
Linear Models or Multiple Regression procedures could be used, but in those, equal variances must be
assumed. The flexibility we need for this analysis can only be achieved using the Mixed Models procedure.
Adding a covariate only adds a couple of steps to the analysis without a covariate. The Two Sample 2 dataset
with the addition of a covariate, blood pressure (BP), becomes the Two Sample Cov dataset.

Two Sample Cov Dataset

Response | Treatment | Subject | BPcov
141 Treatment | 1 110
146 Treatment | 2 104
138 Treatment | 3 128
155 Treatment | 4 136
134 Treatment |5 96
136 Treatment | 6 124
142 Treatment | 7 111
137 Treatment | 8 102
190 Placebo 32 103
186 Placebo 33 133
183 Placebo 34 114
175 Placebo 35 126
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A scatter plot of the two groups is obtained from the Scatter Plots procedure.

Mixed Models - General

Response vs. BPcov
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Setup

To run this example, complete the following steps:

1 Open Two Sample Cov example dataset

From the File menu of the NCSS Data window, select Open Example Data.

Select Two Sample Cov and click OK.

2 Specify the Mixed Models - General procedure options

Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

The settings for this example are listed below and are stored in the Example 2c settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable .........ccccccovviiiiiiieiiiiiiiiiieeee e Response
Subject Variable...........ccoovieiiiiiiii Subject

Repeated (Time) Variable..............cccccoiiiine. <Empty>

Factor (Categorical) Variables .............ccccovvvveeeenn. Treatment
Covariate (Continuous) Variables............ccccuveee... BPCov

Fixed Effects Model .........c.ccooiiiiiiiiie Treatment BPcov
Repeated (Time) Covariance Pattern Groups ........ Treatment
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3 Run the procedure

Mixed Models - General
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« Click the Run button to perform the calculations and generate the output.

Mixed Models Output Excerpt

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Group Estimated Parameter
Number Number Number Value Type

1 1 1 475.0862 Diagonal (Variance)
1 1 2 61.4904 Diagonal (Variance)
Term-by-Term Hypothesis Test Results

Model Num Denom Prob

Term F-Value DF DF Level

Treatment 7.7098 1 23.2 0.010675

BPcov 1.5537 1 18.7 0.227938

These F-Values test Type-Ill (adjusted last) hypotheses.

Least Squares (Adjusted) Means by Covariate Values

Covariates: BPcov = 117.8571

95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 151.3319 2.6855 145.7789 156.8849 23.2
Treatment
Placebo 158.7928 5.0011 148.2852 169.3003 18.0
Treatment 143.8711 1.9628 139.6686 148.0736 14.3

There is not strong evidence of a relationship between BPcov and Response (Prob Level = 0.2279). The
difference in Treatment levels (Placebo and Treatment) is still seen (Prob Level = 0.0107). Because BPcov has
little or no effect on the Response, the variance estimates for each group are similar to those obtain with
including the covariate. Least squares adjusted means are given for the mean value of the covariate.

Comparisons and/or least square means could be obtained for any value of the covariate by specifying the
desired value under the Covariates tab of the Mixed Models procedure. Specifying a covariate value of

BPcov = 130 gives the following output.
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Covariates: BPcov = 130.0000

Comparison Raw Bonferroni
Comparison/ Mean Num  Denom Prob Prob
Covariate(s) Difference  F-Value DF DF Level Level
Treatment
Treatment 7.7098 1 23.2 0.010675
Treatment: Placebo - Treatment 14.9216 7.7098 1 23.2 0.010675 0.010675 [1]
These F-Values test Type-lll (adjusted last) hypotheses.
Least Squares (Adjusted) Means by Covariate Values
Covariates: BPcov = 130.0000
95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 153.5280 3.2161 146.9675 160.0885 30.9
Treatment
Placebo 160.9888 5.2751 150.0228 171.9548 211
Treatment 146.0672 2.7017 140.3448 151.7896 16.2

The F-test (F-Value = 7.71, Prob Level = 0.0107) is the same as the test for Treatment since the lines are
assumed parallel in the fixed model. Thus, the F-test would be the same for any value of BPcov, unless the
fixed model were changed to include the interaction Treatment*BPcov.

The least squares adjusted means (160.99 and 146.07) are adjusted to the covariate value of 130.
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Example 3a - One-Way ANOVA Design Assuming Equal
Variance (One Between-Subject Factor, No Within-Subject
Factors, No Covariates)

In a one-way layout design, two or more (usually three or more) groups are compared. Similar to the two-
sample design, one column contains the response while another column identifies the groups. In this
example, four plant food mixtures (salicylic acid, low iron, high iron, and no food) are compared in their
ability to promote growth in beans. Twenty-eight plots are used in the experiment. The response is the
weight of the beans harvested from the plot.

Bean Dataset

Food | Plot | Weight

Salicyl 1 256
Salicyl 2 284
Salicyl 3 255
Salicyl 4 214
Salicyl 5 283
Salicyl 6 277
Salicyl 7 263
Lowlron | 8 293

Lowlron | 9 326
Lowlron | 10 313
Lowlron | 11 319
Lowlron | 12 321

None 26 238
None 27 259
None 28 243

This dataset could be analyzed using the One-Way Analysis of Variance procedure. The four groups would
be compared by entering Weight as the Response Variable and Food as the Factor Variable.
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Output Excerpt - One-Way ANOVA Procedure

Analysis of Variance Table and F-Test

Reject

Equal
Model Sum of Mean Prob Means? Power
Term DF Squares Square F-Ratio Level (a =0.05) (a =0.05)
Between (Food) 3 64812.39 21604.13 20.6832 0.00000 Yes 1.00000
Within (Error) 24 25068.57 1044.524
Adjusted Total 27 89880.96
Total 28

The equivalence of means is rejected (F-Ratio = 20.68, Prob Level =

0.00000) at the 0.05 alpha level.

Setup

To run this example, complete the following steps:

1 Open Bean example dataset

» From the File menu of the NCSS Data window, select Open Example Data.

« Select Bean and click OK.

2 Specify the Mixed Models - General procedure options

« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 3a settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable .........cccccooiiiiiiiieiiiiiiee, Weight
Subject Variable...........cccovvveiieiiiiiiiiie e Plot
Repeated (Time) Variable..............c.cccoonnieeee. <Empty>
Factor (Categorical) Variables ......................... Food
Fixed Effects Model ...........cccoeviiiiiiiiiieninenns Food
Comparisons Tab

COMPATISON ....iiiiiiieeee e a e All Pairs

3 Run the procedure

« Click the Run button to perform the calculations and generate the output.
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Mixed Models Output

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 1044.5238 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Food 20.6832 3 24.0 0.000001

These F-Values test Type-lll (adjusted last) hypotheses.

Individual Comparison Hypothesis Test Results by Covariate Values

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Food
Food 20.6832 3 24.0 0.000001
Food: Highlron - Lowlron 59.2857 11.7774 1 24.0 0.002180 0.013080 [6]
Food: Highlron - None 121.7143 49.6401 1 24.0 0.000000 0.000002 [6]
Food: Highlron - Salicyl 110.0000 40.5448 1 24.0 0.000001 0.000008 [6]
Food: Lowlron - None 62.4286 13.0592 1 24.0 0.001389 0.008335 [6]
Food: Lowlron - Salicyl 50.7143 8.6181 1 24.0 0.007227 0.043363 [6]
Food: None - Salicyl -11.7143 0.4598 1 24.0 0.504197 1.000000 [6]

These F-Values test Type-lll (adjusted last) hypotheses.

The overall F-test (F-Value = 20.68, Prob Level = 0.0000) comparing the means indicates there is strong
evidence for differences among means. The individual comparison tests, with appropriate Bonferroni
adjustments for multiple testing, indicate there are differences in means among all levels except between

None and Salicylic acid.

The overall F-test (F-Value = 20.68, Prob Level = 0.0000) is identical to the one that results from the One-Way
ANOVA procedure. If equal variances can reasonably assumed, the One-Way ANOVA procedure gives more
detailed information than this procedure and should be used instead. However, for the case of unequal
variances among groups, there is no way to use the One-Way Analysis of Variance procedure to analyze this
dataset, except possibly with a transformation. In this example, the issue of unequal variances is important

since the test for equal variance is rejected (see below).
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The following output is generated from the One-Way Analysis of Variance and Dot Plots procedures.

Weight vs Food
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Highlron Lowlron None Salicyl Highlron Lowlron None Salicyl
Food Food
Tests of the Equality of Group Variances Assumption
Test Prob Reject Equal Variances?
Test Name Value Level (o =0.20)
Brown-Forsythe (Data - Medians) 6.2834 0.00267 Yes
Levene (Data - Means) 8.1436 0.00065 Yes
Conover (Ranks of Deviations) 12.5029 0.00584 Yes
Bartlett (Likelihood Ratio) 16.1344 0.00106 Yes

It appears Highlron group has a much larger variance than the other groups.

Comparing the levels of Food assuming different variance within each group using the Mixed Models

procedure is shown in the next example.
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Example 3b - One-Way ANOVA Design Assuming Unequal
Variance (One Between-Subject Factor, No Within-Subject
Factors, No Covariates)

In this example, four plant food mixtures (salicylic acid, low iron, high iron, and no food) are compared in
their ability to promote growth in beans. Twenty-eight plots are used in the experiment. The response is the
weight of the beans harvested from the plot. This example differs from the previous example in that the
assumption of equal variances between groups is removed.

Bean Dataset

Food | Plot | Weight
Salicyl | 1 256
Salicyl | 2 284
Salicyl | 3 255

None | 26 238
None | 27 259
None | 28 243

In this example, there is no way to use the One-Way Analysis of Variance procedure to analyze this dataset if
unequal variances are assumed. The issue of unequal variances is important since an equal variance test is
rejected (See the plots and equal variance test of the Bean data below). The following output is generated
from the One-Way Analysis of Variance and Dot Plots procedures.

Weight vs Food Dot Plot of Weight
500 500 -
450 0] ®
[ ]

400 | 400 | h
£ £ °
2 350 1 2 350 -
= E

[ ] .. -
® e
300 | 300 4 ° bl
[ ]
o °
250 4 250 | ° oo
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°

200

200

T T T T
Highlron Lowlron None Salicyl
Food Food

T T T T
Highlron Lowlron None Salicyl
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Tests of the Equality of Group Variances Assumption

Test Prob Reject Equal Variances?
Test Name Value Level (a=0.20)
Brown-Forsythe (Data - Medians) 6.2834 0.00267 Yes
Levene (Data - Means) 8.1436 0.00065 Yes
Conover (Ranks of Deviations) 12.5029 0.00584 Yes
Bartlett (Likelihood Ratio) 16.1344 0.00106 Yes

It appears Highlron group has a much larger variance than the other groups.

Setup

To run this example, complete the following steps:

1 Open Bean example dataset

Select Bean and click OK.

From the File menu of the NCSS Data window, select Open Example Data.

2 Specify the Mixed Models - General procedure options

Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.
The settings for this example are listed below and are stored in the Example 3b settings file. To load

these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ... Weight
Subject Variable...........cccovieviiiiii Plot
Repeated (Time) Variable..........c.cccooiiiiiiiiieniiiins <Empty>
Factor (Categorical) Variables ...........ccccceveeeieiinnns Food
Fixed Effects Model ...........ccccveiiiieieiiiieeciice, Food
Repeated (Time) Covariance Pattern Groups ........ Food
Comparisons Tab

COMPATISON ...t All Pairs

3 Run the procedure

Click the Run button to perform the calculations and generate the output.
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Repeated Component Parameter Estimates (R Matrix)
Component Parameter Group Estimated Parameter
Number Number Number Value Type
1 1 1 3174.2381 Diagonal (Variance)
1 1 2 123.2857 Diagonal (Variance)
1 1 3 290.6667 Diagonal (Variance)
1 1 4 589.9048 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Food 27.1319 3 10.8 0.000024

These F-Values test Type-lll (adjusted last) hypotheses.

Individual Comparison Hypothesis Test Results by Covariate Values

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Food
Food 27.1319 3 10.8 0.000024
Food: Highlron - Lowlron 59.2857 7.4612 1 6.5 0.031651 0.189909 [6]
Food: Highlron - None 121.7143 29.9288 1 7.1 0.000896 0.005376 [6]
Food: Highlron - Salicyl 110.0000 22.5018 1 8.2 0.001382 0.008292 [6]
Food: Lowlron - None 62.4286 65.9044 1 10.3 0.000009 0.000051 [6]
Food: Lowlron - Salicyl 50.7143 25.2437 1 8.4 0.000880 0.005283 [6]
Food: None - Salicyl -11.7143 1.0909 1 10.8 0.319185 1.000000 [6]

These F-Values test Type-Ill (adjusted last) hypotheses.

The overall F-test comparing the means indicates there is strong evidence for differences among means.
The individual comparison tests indicate there are differences in means among all levels except between

None and Salicylic acid.

The Repeated Component Parameter Estimates section shows a different residual variance estimate for

each of the four groups. The first variance estimate (3174.2381), corresponding to the high iron food

mixture, is much larger than the others.
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Example 4 - ANCOVA Design (One Between-Subject
Factor, No Within-Subject Factors, One Covariate)

In this example, three weight loss treatments (and a placebo) are compared. Twenty-four patients are
randomly assigned to the three treatments and the placebo. Weight loss is the response. The weight of each
participant before treatment is measured as a covariate. The researchers wish to compare the levels of
Treatment at low (190 Ibs.), medium (230 Ibs.), and high (270 Ibs.) values of initial weight.

Weight Loss Dataset

Trt Patient | IWeight | Loss
TrtA 1 197 3
TrtA 2 245 4
TrtA 3 233 9
TrtA 4 239 -2
TrtA 5 258 3
TrtA 6 190 4
TrtB 7 221 14
TrtB 8 231 16
TrtB 9 224 13
TrtB 10 183 9
TrtB 11 275 26
TrtB 12 254 20
Placebo | 19 187 5
Placebo | 20 192 -1
Placebo | 21 250 2
Placebo | 22 236 6
Placebo | 23 221 3
Placebo | 24 206 1
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A scatter plot of the data is shown below.

Loss vs. IWeight
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This analysis could be run using the Multiple Regression procedure by entering Loss as the Dependent
Variable, IWeight as a Numeric Independent Variable and Trt as a Categorical Independent Variable. The
Default Contrast Type is set to Standard Set. The Custom Model is Trt|IWeight.

Output Excerpt - Multiple Regression Procedure

Analysis of Variance Detail

R2 Lost

If Term(s) Sum of Mean Prob Power
Source DF Removed Squares Square F-Ratio Level (5%)
Intercept 1 4592.667 4592.667
Model 7 0.9682 4695.169 670.7384 69.613 0.0000 1.0000
IWeight 1 0.0005 2.207768 2.207768 0.229 0.6386 0.0736
Trt 3 0.0331 160.7248 53.57495 5.560 0.0083 0.8710
IWeight*Trt 3 0.0822 398.6192 132.8731 13.790 0.0001 0.9990
Error 16 0.0318 154.1646 9.635287
Total(Adjusted) 23 4849.333 210.8406

The significant IWeight*Trt interaction (F-Ratio = 13.790, Prob Level = 0.0001) indicates there are differences
among the slopes of the treatment groups. These results will be compared to those of the Mixed Models
procedure in the output and discussion that follows.
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Setup

To run this example, complete the following steps:

1 Open Weight Loss example dataset
« From the File menu of the NCSS Data window, select Open Example Data.
« Select Weight Loss and click OK.

2 Specify the Mixed Models - General procedure options
« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 4 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ... Loss
Subject Variable............ccoovveiieiiiiiiiiiee s Patient
Repeated (Time) Variable.............ccocciieeneen. <Empty>
Factor (Categorical) Variables............ccccceee..... Trt
Covariate (Continuous) Variables.................... IWeight

3 Run the procedure
« Click the Run button to perform the calculations and generate the output.

Mixed Models Output

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 9.6353 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Trt 5.5603 3 16.0 0.008274
IWeight 31.7737 1 16.0 0.000037
Trt*IWeight 13.7903 3 16.0 0.000106

These F-Values test Type-Ill (adjusted last) hypotheses.
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Individual Comparison Hypothesis Test Results by Covariate Values

Covariates: IWeight = 227.8333

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Trt
Trt 89.7772 3 16.0 0.000000
Trt: Placebo - TrtA -0.4899 0.0649 1 16.0 0.802207 1.000000 [3]
Trt: Placebo - TrtB -12.6863 43.2391 1 16.0 0.000006 0.000019 [3]
Trt: Placebo - TrtC -26.6099 186.0704 1 16.0 0.000000 0.000000 [3]

These F-Values test Type-lll (adjusted last) hypotheses.

Least Squares (Adjusted) Means by Covariate Values

Covariates: IWeight = 227.8333

95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 12.9470 0.6635 11.5405 14.3535 16.0
Trt
Placebo 3.0005 1.4465 -0.0659 6.0669 16.0
TrtA 3.4904 1.2679 0.8025 6.1783 16.0
TrtB 15.6868 1.2767 12.9804 18.3932 16.0
TrtC 29.6104 1.3089 26.8357 32.3852 16.0

The Term-by-Term Hypothesis Test Results are identical to those given in the Multiple Regression procedure
output.

The Prob Level for the interaction Trt*IWeight confirms what is seen in the scatter plot: the slopes differ for
the different treatments. Two important sections of the output that are available in the Mixed Models
procedure that are not available in the Multiple Regression procedure are mean comparisons and least
squares (adjusted) means at specific values of the covariates.

The Individual Comparison Hypothesis Tests of the preceding output, however, are not very useful. They
compare the placebo to each of the treatments at the mean of the covariate (IWeight = 227.83). To better
understand the nature of the interaction, it is useful to compare the placebo to the three treatments at
various values of the covariate. Some caution should be exercised with the number of values that are
chosen because the probability levels (P-values) are adjusted according to the number of comparisons that
are tested. Generally a low, medium, and high value of the covariate should suffice.

The researchers wished to compare the levels of Treatment at low (190 Ibs.), medium (230 Ibs.), and high
(270 Ibs.) values of initial weight. Such values should be chosen prior to collecting the data or at least before
looking at the results. Comparisons and means at these values of the covariate are output by selecting the
Covariate tab, selecting IWeight under Covariate Variable, and entering 190 230 270 under Compute Means
at these Values. The relevant output is shown in the section that follows.
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Covariates: IWeight = 190.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Trt
Trt 11.2974 3 16.0 0.000316 0.000947 [3]
Trt: Placebo - TrtA -1.9360 0.4287 1 16.0 0.521912 1.000000 [9]
Trt: Placebo - TrtB -6.7081 5.2586 1 16.0 0.035722 0.321495 [9]
Trt: Placebo - TrtC -15.2204 29.9618 1 16.0 0.000051 0.000459 [9]
These F-Values test Type-lll (adjusted last) hypotheses.
Covariates: IWeight = 230.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Trt
Trt 94.2700 3 16.0 0.000000 0.000000 [3]
Trt: Placebo - TrtA -0.4071 0.0424 1 16.0 0.839378 1.000000 [9]
Trt: Placebo - TrtB -13.0287 43.6944 1 16.0 0.000006 0.000054 [9]
Trt: Placebo - TrtC -27.2622 188.3200 1 16.0 0.000000 0.000000 [9]
These F-Values test Type-lll (adjusted last) hypotheses.
Covariates: IWeight = 270.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Trt
Trt 79.3289 3 16.0 0.000000 0.000000 [3]
Trt: Placebo - TrtA 1.1218 0.0728 1 16.0 0.790744 1.000000 [9]
Trt: Placebo - TrtB -19.3492 24.2421 1 16.0 0.000153 0.001374 [9]
Trt: Placebo - TrtC -39.3040 112.9663 1 16.0 0.000000 0.000000 [9]
These F-Values test Type-Ill (adjusted last) hypotheses.
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Least Squares (Adjusted) Means by Covariate Values

Covariates: IWeight = 190.0000

95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 7.9562 1.0555 5.7188 10.1937 16.0
Trt
Placebo 1.9901 1.8983 -2.0342 6.0144 16.0
TrtA 3.9261 2.2668 -0.8794 8.7315 16.0
TrtB 8.6982 2.2256 3.9801 13.4164 16.0
TrtC 17.2105 2.0318 12.9033 21.5177 16.0
Covariates: IWeight = 230.0000
95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 13.2329 0.6701 11.8123 14.6535 16.0
Trt
Placebo 3.0584 1.5085 -0.1395 6.2562 16.0
TrtA 3.4655 1.2764 0.7597 6.1712 16.0
TrtB 16.0870 1.2686 13.3977 18.7764 16.0
TrtC 30.3206 1.2927 27.5801 33.0610 16.0
Covariates: IWeight = 270.0000
95.0% 95.0%
Standard Lower Upper
Error Conf. Limit Conf. Limit
Name Mean of Mean for Mean for Mean DF
Intercept
Intercept 18.5095 1.2396 15.8816 21.1374 16.0
Trt
Placebo 4.1266 3.3028 -2.8750 11.1283 16.0
TrtA 3.0048 2.5253 -2.3485 8.3582 16.0
TrtB 23.4759 2.1297 18.9612 27.9906 16.0
TrtC 43.4306 1.6633 39.9047 46.9566 16.0

Examination of the individual comparison hypothesis tests shows that the mean difference from the
placebo for those with a higher initial weight is greater than the mean difference for those with a lower
initial weight, with the exception of Treatment A, for which there is no significant improvement in weight
loss over the placebo.
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Example 5 - Factorial Design (Two Between-Subject
Factors, No Within-Subject Factors, One Covariate)

In a factorial design, more than one fixed factor is analyzed in a single experiment. One variable contains
the response and two or more other variables identify the groups. In this example, a study is conducted to
determine the effect of a growth hormone on trout growth at fish hatcheries. Twelve fish are compared in
the study. Each of the 12 fish receives a different combination of hormone dose (none, low, or high) and
amount of fish food (Level 1, Level 2, Level 3, or Level 4). The response is increase in weight after 3 weeks in

the tank. The length of each fish prior to treatment is measured as a covariate.

Fish Dataset

Fish | Food | Hormone | Length | Wtdiff
1 Level1 | None 5.4 1.408
2 Level1 | Low 6.2 2.808
3 Level1 | High 5.7 4.407
4 Level2 | None 5.3 1.813
5 Level2 | Low 2.9 2.618
6 Level2 | High 4.5 4.708
7 Level3 | None 6.1 2.786
8 Level3 | Low 54 5.247
9 Level3 | High 5.6 5.551
10 Level4 | None 5.0 2.971
11 Level4 | Low 4.8 5.618
12 Level4 | High 5.1 5.563

A scatter plot of the data is shown below.
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This analysis could be run using the Multiple Regression procedure by entering Wtdiff as the Dependent
Variable, Length as a Numeric Independent Variable, and Food and Hormone as Categorical Independent
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Variables. The Default Contrast Type is set to Standard Set. The Custom Model is
Food+Hormone+Length+Hormone*Length.

Output Excerpt - Multiple Regression Procedure

Analysis of Variance Detail

R2 Lost

If Term(s) Sum of Mean Prob Power
Source DF Removed Squares Square F-Ratio Level (5%)
Intercept 1 172.5057 172.5057
Model 8 0.9426 25.00806 3.126008 6.155 0.0813 0.5013
Length 1 0.0000 4.306755E-05 4.306755E-05 0.000 0.9932 0.0500
Food 3 0.3088 8.192474 2.730825 5.377 0.1003 0.4209
Hormone 2 0.0042 0.1111072 0.05555359 0.109 0.8998 0.0571
Length*Hormone 2 0.0028 0.07335056 0.03667528 0.072 0.9319 0.0547
Error 3 0.0574 1.523545 0.5078484
Total(Adjusted) 11 26.53161 2.411964

None of the terms of the model are significant in this example. However, the model can be refined. These
results will be compared to those of the Mixed Models procedure in the output and discussion that follows.

Setup

To run this example, complete the following steps:

1 Open Fish example dataset

« From the File menu of the NCSS Data window, select Open Example Data.
+ Select Fish and click OK.

2 Specify the Mixed Models - General procedure options
« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 5 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ..........cccccvvvvevieiiiiiiiieenee, WTDiff

Subject Variable............cccoveiiiiiiiiiiiie e Fish

Repeated (Time) Variable.............cc.occiieeneen. <Empty>

Factor (Categorical) Variables.............ccccceee..... Food-Hormone

Covariate (Continuous) Variables.................... Length

Fixed Effects Model ............ccooeeiiiiiiiiiiiieneen. Food Hormone Length Hormone*Length

Comparisons Tab

COMPATISON ....viiiiiieieee st All Pairs
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3 Run the procedure

« Click the Run button to perform the calculations and generate the output.

NCSS.com

Mixed Models Output

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 0.5078 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Food 5.3772 3 3.0 0.100307
Hormone 0.1094 2 3.0 0.899798
Length 0.0106 1 3.0 0.924527
Hormone*Length 0.0722 2 3.0 0.931898

These F-Values test Type-Ill (adjusted last) hypotheses.

None of the factors are significant in this example. The model should be refined before examining the
remainder of the output. It is evident that the length of the fish prior to treatment has little effect on the
response, or at least with this small sample size the effect of length is not detectable. Removing the two
non-significant terms associated with the length covariate and re-running the analysis gives the output that

follows.

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 0.3076 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Food 9.0896 3 6.0 0.011930
Hormone 26.4908 2 6.0 0.001053

These F-Values test Type-lll (adjusted last) hypotheses.
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Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Food
Food 9.0896 3 6.0 0.011930
Food: Levell - Level2 -0.1720 0.1443 1 6.0 0.717163 1.000000 [6]
Food: Levell - Level3 -1.6537 13.3347 1 6.0 0.010685 0.064110 [6]
Food: Levell - Leveld -1.8430 16.5630 1 6.0 0.006578 0.039465 [6]
Food: Level2 - Level3 -1.4817 10.7051 1 6.0 0.016995 0.101968 [6]
Food: Level2 - Leveld -1.6710 13.6157 1 6.0 0.010209 0.061256 [6]
Food: Level3 - Leveld -0.1893 0.1748 1 6.0 0.690431 1.000000 [6]
Hormone
Hormone 26.4908 2 6.0 0.001053
Hormone: High - Low 0.9845 6.3017 1 6.0 0.045883 0.137650 [3]
Hormone: High - None 2.8128 51.4387 1 6.0 0.000371 0.001113 [3]
Hormone: Low - None 1.8283 21.7319 1 6.0 0.003461 0.010383 [3]

These F-Values test Type-lll (adjusted last) hypotheses.

With the removal of the covariate terms, the results now show strong evidence of differences between
levels of Food (F-Value = 9.09, Prob Level = 0.0119) and Hormone dose (F-Value = 26.49, Prob Level =
0.0011). Individual comparisons indicate evidence that the Level 1 mean is different from the Level 4 mean
(Bonferroni Prob Level = 0.0395). The High and the Low levels of Hormone are significantly different
(Bonferroni Prob Levels = 0.0011 and 0.0104, respectively) from the level None.

Similar results can be obtained using the General Linear Models procedure. However, the General Linear
Models procedure would not allow the user to model different variances among groups, if this were desired.
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Example 6 - Randomized Complete Block Design (No
Between-Subject Factors, One Within-Subject Factor, No
Covariates)

In a study to compare 3 treatments, three patients from each of 14 doctors are randomly assigned to each
of the three treatments. A single response is measured for each patient following treatment. The resultis a
randomized complete block design with 14 blocks (doctors). The goal is to determine whether there are any
differences among the three treatments. The data are contained in the RCBD data set.

RCBD Dataset

Doctor | Patient | Trt | Response
1 1 A |57
1 2 B |64
1 3 C |86
2 4 A |85
2 5 B |65
13 38 B |28
13 39 C |94
14 40 A |32
14 41 B |33
14 42 C |84

A plot showing the 3 patients for each doctor is shown below.

Response vs Trt by Doctor
120

100 4 Doctor

80 -

Response

60 4

40 4

20

Because there are no covariates, this analysis could be run using the Repeated Measures Analysis of
Variance procedure by entering Response as the Response Variable, Doctor as the Subject Variable, and Trt
as Within Factor 1. The Model Specification is Full model except subject interactions combined with error.
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Output Excerpt - Repeated Measures Analysis of Variance Procedure

Analysis of Variance Table

Source Sum of Mean Prob Power

Term DF Squares Square F-Ratio Level (Alpha=0.05)
A: Doctor 13 4232.119 325.5476 1.83 0.091201

B: Trt 2 12507.19 6253.595 35.23 0.000000* 1.000000

S 26 4614.81 177.4927

Total (Adjusted) 41 21354.12

Total 42

* Term significant at alpha = 0.05

The difference in Treatment levels is highly significant (F-Ratio = 35.23, Prob Level = 0.000000). These results
will be compared to those of the Mixed Models procedure in the output and discussion that follows.

Setup

To run this example, complete the following steps:

1 Open RCBD example dataset

« From the File menu of the NCSS Data window, select Open Example Data.

o Select RCBD and click OK.

2 Specify the Mixed Models - General procedure options

« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 6 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable .........ccccccoovviiiiiiie e, Response
Subject Variable............cccoveiiiiiiiiiiiie e Doctor
Repeated (Time) Variable..............c.cccoonniee. <Empty>
Factor (Categorical) Variables ......................... Trt

Fixed Effects Model .........c.cccooiiiiiiieiiiiiiee. Trt
Random Model (Subject Terms Only).............. Doctor

Comparisons Tab

COMPATISON ....viiiiiiiii et a e All Pairs

3 Run the procedure

+ Click the Run button to perform the calculations and generate the output.
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Mixed Models Output

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 49.3516 Doctor

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 177.4927 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Trt 35.2330 2 26.0 0.000000

These F-Values test Type-Ill (adjusted last) hypotheses.

Individual Comparison Hypothesis Test Results by Covariate Values

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Trt
Trt 35.2330 2 26.0 0.000000
Trt: A-B -1.8571 0.1360 1 26.0 0.715255 1.000000 [3]
Trt: A-C -37.5000 55.4600 1 26.0 0.000000 0.000000 [3]
Trt:B-C -35.6429 50.1029 1 26.0 0.000000 0.000000 [3]
These F-Values test Type-Ill (adjusted last) hypotheses.
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Subject Plots

Response vs Sequence Number by Doctor Response vs Sequence Number by Trt
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The results of this test match those of the Repeated Measures ANOVA procedure (F-Value = 35.23, Prob
Level = 0.0000). All the reports indicate that the mean response for Treatment C is much higher than A and
B (the Bonferroni Prob Levels for Avs. C and B vs. C are both extremely small).

The second subject plot seems to indicate that the variation within responses of Treatment C is considerably
smaller than the variation within Treatments A and B. This can be accounted for by entering Trt for Groups
in the Repeated Variance Pattern on the Variables tab.

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 8.7505 Doctor

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Group Estimated Parameter
Number Number Number Value Type

1 1 1 276.0158 Diagonal (Variance)
1 1 2 297.4464 Diagonal (Variance)
1 1 3 76.3315 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Trt 41.4257 2 17.1 0.000000

These F-Values test Type-lll (adjusted last) hypotheses.

The conclusions do not change when the unequal variance is accounted for, but the estimated variances are
indeed quite different across treatments. The estimated variances for Treatments A and B are 276.0158 and
297.4464, respectively, while the estimated variance for Treatment C is only 76.3315. These tests based on
unequal variance assumptions are more accurate than those where equal variances were assumed.
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Example 7 - Complex Split-Plot Design (One Between-
Subject Factor, Two Within-Subject Factors, Two
Covariates)

In a standard split-plot design, plots are randomized to a between-plot treatment and are also sub-divided,
with each sub-division receiving a different within-plot treatment. This example involves a more complex
split-design with an additional within-plot factor and two covariates.

In a study to compare the effectiveness of 3 tutoring methods, 84 students (42 male, 42 female) are
randomly assigned to 14 tutors (7 graduates, 7 undergraduates) in groups of 6 (3 male, 3 female). Each
tutor uses a different tutoring method for each student according to the scheme below. A pre-exam is
administered to each student before the semester of tutoring begins. IQ is also obtained for each student.
The response is the score on an exam taken at the end of the semester.

Tutor Dataset

Educ | Tutor | Student | Method | Gender | Preexam | IQ | Exam
Undergr | 1 1 A M 45 117 | 70
Undergr | 1 2 A F 35 113 | 84
Undergr | 1 3 B M 68 94 | 95
Undergr | 1 4 B F 47 103 | 77
Undergr | 1 5 C M 25 100 | 78
Undergr | 1 6 C F 24 95 | 88
Undergr | 2 7 A M 16 96 | 80
Undergr | 2 8 A F 38 99 |75
Grad 14 79 A M 27 109 | 77
Grad 14 80 A F 36 104 | 81
Grad 14 81 B M 24 79 | 84
Grad 14 82 B F 27 99 | 72
Grad 14 83 C M 33 93 |75
Grad 14 84 C F 39 109 | 63

The only procedure that can be used to incorporate all the variables of this analysis in a single model is the
Mixed Models procedure.

Setup
To run this example, complete the following steps:
1 Open Tutor example dataset

« From the File menu of the NCSS Data window, select Open Example Data.
» Select Tutor and click OK.
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2 Specify the Mixed Models - General procedure options
« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 7 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ..., Exam

Subject Variable............ccooiiiiiiie Tutor

Repeated (Time) Variable..............cccccovvveeneennn. <Empty>

Factor (Categorical) Variables..............ccccc....... Educ,Method-Gender

Covariate (Continuous) Variables ...Preexam-IQ

Fixed Effects Model ...........cccovvveveeiiiiiiinieneen. Educ Method Gender Preexam IQ
Random Model (Subject Terms Only).............. Tutor

3 Run the procedure
« Click the Run button to perform the calculations and generate the output.

Mixed Models Output

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 0.8100 Tutor

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 79.4941 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Educ 0.6770 1 14.3 0.424099
Method 0.9964 2 65.8 0.374712
Gender 0.2135 1 65.4 0.645537
Preexam 0.0525 1 76.1 0.819412
(@) 1.0666 1 77.0 0.304948

These F-Values test Type-lll (adjusted last) hypotheses.

There is no statistical evidence of differences among the levels of Education, Method, or Gender (all Prob
Levels > 0.05).
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Example 8 - Cross-Over Design (No Between-Subject
Factors, Two Within-Subject Factors, One Covariate)

In a basic two-level cross-over design, each subject receives both treatments, but (approximately) half
receive the two treatments in the opposite order. In this example, researchers are comparing two drugs for
their effect on heart rate in rats. Each rat is given both drugs, with a short washout period between drug
administrations, but the order of the drugs is reversed in half of the rats. An initial heart rate (IHR)
measurement is taken immediately before administration of each of the drugs.

Cross Dataset

Rat | Period | Trtcross | IHR | HR
1 1 Drug A | 389 | 357
1 2 Drug B 383 | 381
2 1 Drug B 372 | 409
2 2 Drug A 390 | 385
20 |1 Drug B | 408 | 403
20 | 2 Drug A 391 | 371
Setup

To run this example, complete the following steps:

1 Open Cross example dataset
» From the File menu of the NCSS Data window, select Open Example Data.
o Select Cross and click OK.

2 Specify the Mixed Models - General procedure options
« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 8 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable .........ccccccoiiiiiiiiiiiiiiiee HR

Subject Variable............ccoovieiieiiiiiiiiiie e Rat

Repeated (Time) Variable..............c.cccoonniee. <Empty>

Factor (Categorical) Variables ......................... Period-Trtcross
Covariate (Continuous) Variables.................... IHR

Fixed Effects Model ... Trtcross Period IHR
Random Model (Subject Terms Only).............. Rat
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3 Run the procedure
« Click the Run button to perform the calculations and generate the output.

Mixed Models Output

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model
Number Number Value Term
1 1 6.9232 Rat

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 189.6101 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Trtcross 3.9878 1 20.6 0.059200
Period 0.4899 1 17.5 0.493163
IHR 2.0013 1 35.6 0.165844

These F-Values test Type-Ill (adjusted last) hypotheses.

The F-test for Trtcross is nearly significant (F-value = 3.9978, Prob Level = 0.0592) at the 0.05 level. There
appears to be no period effect (F-value = 0.49, Prob Level = 0.4932) nor relationship between the initial heart
rate (F-value = 2.0013, Prob Level = 0.1658) and the response heart rate.

The advantages of using mixed models in cross-over designs are usually more pronounced when there is
missing data. Missing values often occur in cross-over designs when subjects fail to appear for the second
treatment. Another advantage of mixed models in cross-over designs over conventional analyses occurs
when there are three or more treatments involved. In such cases, the cross-over design may be considered
a repeated measures design, and specific covariate patterns can be used to model the similarity in repeated
measurements. That is, measurements that are taken closer together may be expected to vary more
similarly, while measurements at distant periods may not. The Mixed Models procedure provides greater
flexibility in modeling options for such situations.
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Example 9 - Random Coefficients Model (One Between-
Subject Factor, No Within-Subject Factors, One Covariate,
Unequal Time Points, Missing Data)

Researchers would like to determine the effect of a new hair loss treatment. Eighteen men are randomly
divided into two groups. One group receives the placebo (shampoo without treatment), the other group
receives the hair loss treatment (shampoo with treatment). The participants are asked to shampoo daily and
return to the lab after every two months for one year. At each visit, participants are given a hair re-growth
score. As is sometimes the case with human subjects, the return visits were not as scheduled. Some
participants returned before or after the scheduled two month period, while some others dropped out of
the study.

Hair Dataset

Treatment | Individual | Time | Regrowth
Placebo 1 2 14
Placebo 1 4 5
Placebo 1 7 3
Placebo 1 9 7
Placebo 1 12 8
Placebo 2 2 6
Placebo 2 4 3
Placebo 3 2 5
Placebo 3 5 2
Placebo 3 10 4
Placebo 4 2 7
Placebo 4 4 9
Trt 17 6 7
Trt 17 12 3
Trt 18 2 7
Trt 18 4 10
Trt 18 6 14
Trt 18 8 17
Setup

To run this example, complete the following steps:

1 Open Hair example dataset

« From the File menu of the NCSS Data window, select Open Example Data.
« Select Hair and click OK.
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2 Specify the Mixed Models - General procedure options

« Find and open the Mixed Models - General procedure using the menus or the Procedure Navigator.

« The settings for this example are listed below and are stored in the Example 9 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Response Variable ..., Regrowth

Subject Variable............ccooiiiiiiie Individual

Repeated (Time) Variable..............cccccovvveeneennn. Time

Factor (Categorical) Variables..............ccccc....... Treatment

Covariate (Continuous) Variables ...Time

Fixed Effects Model ............cccceeviiiiiiiinneiiieenn, Treatment Time Treatment*Time

Random Model (Subject Terms Only)

Individual Individual*Time

COVANANCES. .....vvvvvrererererererrrrrererersssrrrensrenene. Checked

3 Run the procedure

« Click the Run button to perform the calculations and generate the output.

Mixed Models Output

Random Component Parameter Estimates (G Matrix)

Component Parameter Estimated Model

Number Number Value Term

1 1 16.6319 Individual

1 2 1.8015 Individual*Time

1 3 -4.2599 Individual, Individual*Time

Repeated Component Parameter Estimates (R Matrix)

Component Parameter Estimated Parameter
Number Number Value Type
1 1 5.9013 Diagonal (Variance)

Term-by-Term Hypothesis Test Results

Model Num Denom Prob
Term F-Value DF DF Level
Treatment 0.2042 1 13.6 0.658459
Time 7.7449 1 12.3 0.016219
Treatment*Time 9.4960 1 12.3 0.009259
These F-Values test Type-Ill (adjusted last) hypotheses.
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Individual Comparison Hypothesis Test Results by Covariate Values

Covariates: Time = 6.0000

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level
Treatment
Treatment 18.7211 1 151 0.000593
Treatment: Placebo - Trt -11.8425 18.7211 1 15.1 0.000593 0.000593 [1]

These F-Values test Type-Ill (adjusted last) hypotheses.

Subject Plots

Regrowth vs Time by Treatment
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The significant Treatment*Time interaction (F-Value = 9.50, Prob Level = 0.0093) indicates that the
differences between the Treatment and the Placebo are different at different times. If comparisons are
made at times 2, 7, and 12, the results are

Individual Comparison Hypothesis Test Results by Fixed Effects

Comparison Raw Bonferroni
Comparison/ Mean Num Denom Prob Prob
Covariate(s) Difference F-Value DF DF Level Level

Treatment: Placebo - Trt

Time = 2.0000 -3.2053 3.9286 1 14.4 0.066901 0.200704 [3]
Time = 7.0000 -14.0017 17.5590 1 145 0.000843 0.002528 [3]
Time = 12.0000 -24.7981 13.8925 1 13.2 0.002479 0.007438 [3]

These F-Values test Type-lll (adjusted last) hypotheses.

There is strong evidence that the difference in means increases as time increases.
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